Replacement parts and specifications are subject to change. For a current parts list, contact your authorized service/support center.
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of Figures</td>
<td>6</td>
</tr>
<tr>
<td><strong>Introduction</strong></td>
<td>8</td>
</tr>
<tr>
<td>Document conventions</td>
<td>8</td>
</tr>
<tr>
<td>About the PS-50</td>
<td>8</td>
</tr>
<tr>
<td>How the PS-50 operates</td>
<td>8</td>
</tr>
<tr>
<td>Before you service the PS-50</td>
<td>8</td>
</tr>
<tr>
<td>Tools you will need</td>
<td>9</td>
</tr>
<tr>
<td>Precautions</td>
<td>9</td>
</tr>
<tr>
<td><strong>Installing Hardware</strong></td>
<td>13</td>
</tr>
<tr>
<td>About the installation process</td>
<td>13</td>
</tr>
<tr>
<td>Change the language of the PS-50</td>
<td>13</td>
</tr>
<tr>
<td>Checking the customer site</td>
<td>14</td>
</tr>
<tr>
<td>Printer readiness</td>
<td>15</td>
</tr>
<tr>
<td>Setting customer expectations</td>
<td>15</td>
</tr>
<tr>
<td>Unpacking the PS-50</td>
<td>16</td>
</tr>
<tr>
<td>Connecting the PS-50</td>
<td>16</td>
</tr>
<tr>
<td>(Optional) Connecting the monitor, keyboard, mouse, and power</td>
<td>20</td>
</tr>
<tr>
<td>Connecting to the printer and the network</td>
<td>20</td>
</tr>
<tr>
<td>Starting the PS-50 for the first time</td>
<td>21</td>
</tr>
<tr>
<td>Configuring a static IP address for the PS-50</td>
<td>22</td>
</tr>
<tr>
<td>Completing the installation</td>
<td>22</td>
</tr>
<tr>
<td><strong>Using the PS-50</strong></td>
<td>23</td>
</tr>
<tr>
<td>Fiery Ticker</td>
<td>23</td>
</tr>
<tr>
<td>Printing PS-50 pages from the monitor, keyboard, and mouse</td>
<td>23</td>
</tr>
<tr>
<td>Command WorkStation</td>
<td>24</td>
</tr>
<tr>
<td>About Configure</td>
<td>24</td>
</tr>
<tr>
<td>Using the PS-50 on Fiery QuickTouch</td>
<td>25</td>
</tr>
<tr>
<td>Overview of Fiery QuickTouch options</td>
<td>26</td>
</tr>
<tr>
<td>Quick Launch</td>
<td>28</td>
</tr>
<tr>
<td>Quick options</td>
<td>28</td>
</tr>
<tr>
<td>Using the PS-50 on the printer control panel</td>
<td>29</td>
</tr>
</tbody>
</table>
Network status LEDs ................................................................. 30
Starting, shutting down, restarting, and rebooting ................................................................. 31
Replacing parts .................................................................................. 34
Overview ......................................................................................... 34
PS-50 hardware ................................................................................ 35
Accessing internal components .............................................................. 39
  Shutting down the system ................................................................ 39
  Opening the PS-50 ........................................................................ 39
Fiery QuickTouch display module ...................................................... 42
Removing and replacing boards ............................................................. 46
  Printer interface board .................................................................... 46
Motherboard .................................................................................... 47
  Motherboard replacement overview ................................................. 48
  Removing the motherboard ................................................................. 48
  Replacing the motherboard ................................................................. 52
  Verifying new motherboard installation, and transferring options and BIOS information ............ 55
Replacing parts on the motherboard ......................................................... 58
  DIMMs ..................................................................................... 58
  CPU ....................................................................................... 59
  Battery ..................................................................................... 63
  Jumpers ..................................................................................... 65
Fan ................................................................................................. 65
Power supply ................................................................................... 67
Hard disk drive .................................................................................. 69
DVD drive ........................................................................................ 73
Restoring and verifying functionality after service ........................................ 75
Performing Backup and Restore ............................................................. 76
Backup recommendations ........................................................................ 77
  When backing up an existing PS-50 installation ..................................... 78
Backing up the system configuration ....................................................... 78
Restoring the system configuration .......................................................... 80
Using Fiery System Restore ................................................................. 81
Using Fiery System Installer ........................................................................................................... 83
Backup with Fiery System Installer ................................................................................................. 84
Restore with Fiery System Installer ................................................................................................. 85
Installing system software .................................................................................................................. 89
To install and verify the system software installation ....................................................................... 89
Installing the Fiery QuickTouch software ......................................................................................... 91
Installing software patches .................................................................................................................. 94

Troubleshooting ................................................................................................................................ 96
Preliminary on-site checkout ................................................................................................................ 96
Checking external connections ............................................................................................................ 96
Checking internal components ............................................................................................................ 97
Inspecting the system ............................................................................................................................ 97
Troubleshooting information ................................................................................................................ 108
Job Error Report ................................................................................................................................... 109
System Logs .......................................................................................................................................... 110

Specifications ....................................................................................................................................... 112
Hardware features ................................................................................................................................. 112
Physical specifications ........................................................................................................................... 112
Networking and connectivity ............................................................................................................... 112
Safety and emissions compliance .......................................................................................................... 112
Safety approvals ..................................................................................................................................... 113
EMI/EMC approvals ............................................................................................................................... 113

Servicing the PS-50 with furniture ....................................................................................................... 114
Procedures ............................................................................................................................................ 114

Index ....................................................................................................................................................... 115
List of Figures

Figure 1: Space requirement for the PS-50 without optional furniture .................................................. 14
Figure 2: Front and connector panel ............................................................ 18
Figure 3: Inside the front panel ................................................................. 19
Figure 4: PS-50 power switch ................................................................. 21
Figure 5: PS-50 power button ................................................................. 21
Figure 6: Fiery Ticker status bar .............................................................. 23
Figure 7: Fiery QuickTouch ................................................................. 25
Figure 8: Fiery QuickTouch Home screen .............................................. 26
Figure 9: Queue job list ................................................................. 27
Figure 10: Printed jobs list ................................................................. 27
Figure 11: Quick launch menu ............................................................ 28
Figure 12: Quick options menu ............................................................ 29
Figure 13: Ethernet network port (upper RJ-45) ........................................ 30
Figure 14: PS-50 power switch ............................................................ 31
Figure 15: PS-50 power button ............................................................ 31
Figure 16: Front and connector panel ................................................ 35
Figure 17: Inside the front panel ............................................................ 36
Figure 18: Exploded view of components .............................................. 37
Figure 19: Power and data cable connections ......................................... 38
Figure 20: Removing the left panel ....................................................... 40
Figure 21: Removing the right panel ....................................................... 40
Figure 22: Front bezel anchor screw ...................................................... 41
Figure 23: Front bezel tabs ................................................................. 41
Figure 24: Printer interface board ......................................................... 46
Figure 25: Motherboard ................................................................. 50
Figure 26: Releasing a DIMM ............................................................. 59
Figure 27: CPU cooling assembly ......................................................... 60
Figure 28: Removing/replacing the CPU .............................................. 62
Figure 29: Motherboard battery ................................................................. 64
Figure 30: Removing/replacing the fan ......................................................... 66
Figure 31: Removing/replacing the power supply ........................................ 68
Figure 32: Removing/replacing the hard disk drive bracket .......................... 71
Figure 33: Removing/replacing the hard disk drive from/in the hard disk drive bracket .................. 72
Figure 34: Removing/replacing the DVD drive ................................................ 74
Figure 35: Reset and download buttons on the Fiery QuickTouch ................... 93
Figure 36: PS-50 installed on the furniture ..................................................... 114
Introduction

This document includes information about servicing the Printing System 50. In this document, the Printing System 50 is referred to as "the PS-50."

Document conventions

Note: The NOTE format highlights important messages and additional information.

Warning: The WARNING icon indicates a warning concerning operations which, if not performed correctly, may lead to death or injury. To use the PS-50 safely, always pay attention to WARNING icons and messages.

Caution: The CAUTION icon indicates a caution concerning operations which, if not performed correctly, may lead to injury. To use the PS-50 safely, always pay attention to CAUTION icons and messages.

Important: The IMPORTANT icon indicates operational requirements and restrictions. To operate the PS-50 correctly and avoid damage to the PS-50 or other property, always pay attention to IMPORTANT icons and messages.

About the PS-50

The PS-50 adds computer connectivity and highly efficient PostScript and PCL printing ability to the TASKalfa Pro 15000c printer.

With the PS-50, customers can use the printer as a PostScript printer and scanner. Once it is connected to the printer through the network, customers can print to the PS-50 from supported client computers on the network.

The PS-50 ships with software pre-installed so that customers can use it immediately. However, as part of servicing the PS-50, you may need to reinstall software.

How the PS-50 operates

When a customer prints, the motherboard and printer interface board process image data. The printer interface board is a custom board and allows the PS-50 to communicate with the printer. The CPU controls the transfer of image data to and from the motherboard and runs the PostScript interpreter. DIMMs hold image data during printing.

The interpreter rasterizes the page description file and compresses the image pattern into memory using compression technology. The interpreter outputs the compressed raster data through the image frame buffer memory to the printer interface board. The raster data is sent to the printer, which then renders the image on paper at maximum speed.

Before you service the PS-50

Before you service the PS-50, it is strongly recommended that you make sure that you have the required tools (page 9) and carefully review all precautions.
Also, keep in mind that the most common cause of a hardware problem is a faulty or loose connection. Before you replace an expensive component, check internal and external connections (see page 35).

Tools you will need
To install or service the PS-50, you will need the following tools and parts:

- ESD wrist grounding strap and antistatic mat
- Flathead screwdriver
- #0, #1, and #2 Phillips head screwdrivers
  When servicing the Fiery QuickTouch, use a screwdriver with a magnetic tip.
- Needle nose pliers
- The PS-50 documentation, including the customer media pack and any related service bulletins

⚠️ Important: Avoid touching magnetic tools to storage media such as hard disk drives. Contact between magnetic tools and magnetic storage media may result in data corruption.

Precautions
This section includes information about how to safely operate and service the PS-50 and how to avoid damage to PS-50 components.

Report shipping damage
If there is evidence of shipping damage, save the shipping boxes and damaged parts. Call the shipper immediately to file a claim and notify your authorized service/support center.

Do not change an existing network
The PS-50 is probably connected to an existing Local Area Network (LAN) based on Ethernet hardware. The network is the link between the customer’s computer, existing laser printers, and other prepress equipment. Never disturb the LAN by breaking or making a network connection, altering termination, installing or removing networking hardware or software, or shutting down networked devices without the knowledge and express permission of the site administrator.

Do not assign an IP address to the PS-50
Only the site administrator should assign an IP address to a network device, including the PS-50. If you enter an incorrect IP address for the PS-50, errors may occur on connected devices.

Handling boards
When handling a printed circuit board, do not bend it. Hold it by opposing edges, rather than by the corners.

Handling the hard disk drive
To ensure that you do not damage the hard disk drive, do the following:
• Follow electrostatic discharge (ESD) precautions.
• Keep magnets and magnetic-sensitive objects away from the hard disk drive.
• Do not loosen or remove the screws on the top of the hard disk drive. Doing so voids the warranty.
• Handle the hard disk drive by its sides and avoid touching the printed circuit board.
• Do not drop, jar, or bump the hard disk drive.
• Before you remove or install a hard disk drive, allow it to reach room temperature.

Avoid magnets
Keep magnets and magnetic-sensitive objects away from electronic components, especially the hard disk drive.

Avoid fan blades

⚠️ Warning: The PS-50 contains hazardous moving parts. When servicing the PS-50, keep away from moving fan blades.

⚠️ Attention: ce produit contient des pièces mobiles dangereuses. Veuillez le maintenir à l’écart des pales de ventilateur lors de sa maintenance.

Attenzione: questo prodotto include parti mobili pericolose. Mantenere la distanza dalle pale della ventola quando sono in uso.

Warnung: Dieses Produkt verfügt über gefährliche Teile, die sich bewegen. Halten Sie bei der Instandhaltung Abstand zu den sich bewegenden Ventilatorblättern.

Advertencia: Este producto contiene piezas móviles peligrosas. Cuando realice el mantenimiento de este producto, manténgase alejado de aspas de ventilador en movimiento.

Waarschuwing: dit product bevat gevaarlijke bewegende delen. Blijf uit de buurt van bewegende ventilatorbladen bij het uitvoeren van onderhoudswerkzaamheden aan dit product.

Aviso: este producto contém peças removíveis perigosas. Ao realizar a manutenção deste produto, mantenha-se longe das lâminas removíveis do ventilador.

Use caution with sharp edges
The edges of some PS-50 components are sharp.

Electrostatic discharge
When you work with electronic components, electrostatic discharge is a concern since it can destroy circuits, or damage them, reducing their life span. The area around the printer is most likely not static-free, and electrostatic discharge could occur.
Do the following to avoid damage due to electrostatic discharge:

- Work on a grounded antistatic mat.
- Wear an antistatic wristband, attached to the same location as the antistatic mat.
- Before you remove an electronic component from the shipping box, touch a metal area of the printer to discharge static from your body.
- After you remove an electronic component from the shipping box, place it face up on a grounded antistatic surface.
- Leave electronic components in antistatic bags until you are ready to use them.
- Do not walk on carpet or vinyl while carrying an electronic component, unless it is in an antistatic bag.
- If you remove an electronic component from the printer, immediately place it in an antistatic bag.

**The power cable**

Observe the following guidelines:

- Only use the power cable that shipped with the PS-50 or an appropriate replacement power cable. For replacement parts, see your authorized service support center.
- Before you open the PS-50, unplug the PS-50.
- Keep the power cable away from foot traffic.
- Do not place objects on the power cable.
- Do not plug the PS-50 into a 2-hole, ungrounded outlet by means of a 3-prong adapter.
- Do not plug the PS-50 into a circuit connected to heating or refrigeration equipment (including a water dispenser).
- Do not plug the PS-50 into a switchable outlet.
- Do not pull the cable to unplug the PS-50. Instead, pull the plug.
- Do not tamper with or disable the power cable grounding plug.
- Do not use an extension cord.

**Do not bring liquids near the PS-50**

If liquid spills on the PS-50, immediately unplug the PS-50.

**Do not open the power supply**

For more information about the power supply, see “Power supply” on page 67.

**Do not open the hard disk drive**

For more information about the hard disk drive, see “Hard disk drive” on page 69.
Power supply cord notice

⚠️ **Important:** The power supply cord is used as the main disconnect device. Ensure that the power outlet is located/installed near the equipment and is easily accessible.

Lithium battery notice

⚠️ **Caution:** There is a danger of explosion if the battery is replaced with an incorrect type. Replace a battery only with the same type recommended by the manufacturer. Dispose of used batteries according to local regulations.

Short circuit protection

⚠️ **Warning:** This product relies on the building’s installation for short-circuit (overcurrent) protection. Ensure that a fuse or circuit breaker no larger than 120 VAC, 15A U.S. (240 VAC, 10A international) is used on the phase conductors (all current-carrying conductors).

Lift the PS-50 carefully

Never lift the PS-50 by grasping the top panel. The top panel does not support the weight of the PS-50.

ATTENTION: Ne jamais soulever le serveur d'impression par sa partie supérieure : celle-ci ne peut pas supporter le poids du système.

AVVERTENZA: Il server di stampa non deve essere mai sollevato afferrandolo dal pannello superiore, in quanto quest’ultimo non può sostenere il peso dell’intero sistema.


ADVERTENCIA: No levante nunca el servidor de impresión agarrándolo por el panel superior. El panel superior no soporta el peso del sistema.

ADVERTÊNCIA: Nunca erga o servidor de impressão pelo painel superior. O painel superior não suporta o peso do sistema.

WAARSCHUWING: Til de afdrukservier nooit op door het bovenpaneel vast te nemen. Het bovenpaneel kan het gewicht van het systeem niet dragen.
Installing Hardware

About the installation process

It is strongly recommended that you review this chapter before you install the PS-50. Also keep in mind that installation problems are easier to avoid and diagnose if you proceed from the component level to the system level, verifying functionality at each step.

Since the PS-50 is connected to the customer’s network, be sure to coordinate your installation schedule with the administrator at the customer site. For information about network setup, refer the site administrator to Configuration Guide, which is part of the user documentation set.

If necessary, you can change the default language of the PS-50 set at the factory (see “Change the language of the PS-50” on page 13).

To install the PS-50

1. Check installation requirements and verify site conditions.
   - If possible, obtain verification that the network is operational (see page 14).

2. Unpack the PS-50 (see page 16).

3. If applicable, connect the monitor, keyboard, mouse, and furniture to the PS-50.
   - For more information on setting up the furniture, see the documentation that comes with the furniture kit.

4. Connect the following cables (see page 16).
   - Power cable
   - Printer interface cable
   - Network cable (upper RJ-45)

5. (Optional) If the PS-50 requires a static IP address (for example, in a non-DHCP network environment), work with the site administrator to configure a static IP address (see page 22).

6. Complete the installation (see page 22).

Remind site administrator to install current user software on client computers that print to the PS-50 (see Printing and Utilities, which are part of the user documentation set).

Change the language of the PS-50

If necessary you can change the language of the PS-50 set at the factory.

To change the PS-50 language from Fiery QuickTouch

1. On the Fiery QuickTouch Home screen, select Quick Launch > Settings (see Figure 8 on page 26).
2 Log in to the PS-50 as Administrator.

   The default password for the Administrator is Fiery.1 (case-sensitive).

3 Select Language, and then from the Select language drop-down, select the language you want.

4 Press Save Changes.

5 Press Reboot.

Wait until the PS-50 reboots and becomes Idle. It may take up to 15 minutes to complete the system language change.

**To change the PS-50 language from Configure**

1 Access Configure (see page 24).

2 In Configure, click Fiery Server > Regional Settings,

3 In the Server Language drop-down list, select a language.

4 Click Save.

5 Click Continue, then click Reboot.

Wait until the PS-50 reboots and becomes Idle. It may take up to 15 minutes to complete the system language change.

**Checking the customer site**

Before you install the PS-50, check the site conditions and inform the customer of any installation requirements.

**Figure 1:** Space requirement for the PS-50 without optional furniture

1 20cm+ (8 in.)

2 PS-50

3 Connector panel

4 Side panel

5 Fiery Quick Touch display panel

6 Front panel
**Printer readiness**

- Is the printer configured for use with the PS-50? (For the proper settings, see the documentation that accompanies the printer.)

- Is space available near the printer for the PS-50 and the optional furniture?
  
  Make sure that adequate space is available for the PS-50 and the furniture. Allow enough space at the connector panel for the cables to route easily and at the side panel so that the PS-50 does not interfere with use of or service to the printer (such as clearing a paper jam). You may need to move the printer away from the wall so that the interface connectors are accessible.

- Does the printer require service or adjustments?
  
  Print the printer Test Page before you install the PS-50.

  If the image indicates that the printer needs adjustment, inform the customer. After getting approval, complete the necessary printer service.

**Power**

- Is a dedicated, grounded electrical outlet for the PS-50 available near the printer?
  
  Locate the grounded electrical outlet that will supply power to the PS-50. Do not run the PS-50 and the printer on the same circuit. If the customer has provided one, use a surge suppressor for the PS-50.

**Network**

- Make sure that the network is available at the time set for installation.

- Verify with the network administrator that the network is functioning before you attach the PS-50.

- Make sure that the configuration requirements specified in *Configuration and Setup* (which is part of the user documentation set) have been met for remote computers and the network.

**Setting customer expectations**

When the site is ready, installation of the PS-50 takes about one hour. Inform the customer of the following:

- Some nodes on the network may be unavailable for up to one hour.

- The printer may be unavailable for up to one hour.

- The network administrator must be available during the installation for network connectivity.

  Equipment downtime and impact on the network can be minimized if the network administrator installs a network connector for the PS-50 and confirms network functionality with the connector in place before the date scheduled for the PS-50 installation.

- The network administrator must make a networked computer available during the installation. The appropriate software must be installed in advance. Documentation for the networked computer and network operating software should be available.
Installation and Service Guide: Printing System 50
Installing Hardware

- The network administrator must install the user software shipped with the PS-50 onto networked Windows and Mac OS computers that print to the PS-50 (user documentation is also included).

**Note:** This document covers hardware installation and service and provides general information about connecting the PS-50 to the customer’s network. Network Setup and configuration information exceeds the scope of this document. For Network Setup and configuration information, refer the network administrator to *Configuration and Setup*, which is part of the user documentation set.

**Unpacking the PS-50**

The PS-50 is assembled and shipped from the factory with all necessary cables (except the network cable) and documentation.

Before you unpack the PS-50, it is strongly recommended that you review all “Precautions” on page 9 to avoid injury or damage to the PS-50.

- The PS-50 weighs approximately 20Kg. Be careful when moving the device.

**To unpack the PS-50**

It is strongly recommended that you save all packing materials in case you need them later (for example, if you discover something is damaged and need to return it). Do not immediately discard packing materials.

1. Open the box and remove the packing material.
   - Save the original boxes and packing material, in case you need to transport the PS-50 at a later date.

2. Remove the contents from the top container. Inspect the contents for visible damage.

3. Set aside the remaining components from the top container.

4. Remove the top container and any packing material.

5. Carefully lift the PS-50 out of the box.
   - If you notice shipping damage to any component, save the shipping container, in case the carrier needs to see it.
   - Call the carrier immediately to report the damage and file a claim.

6. Give the media pack to the customer or network administrator.
   - Let the customer or network administrator know that in order to take full advantage of the PS-50, the user software must be installed on computers that will print to the PS-50.

**Connecting the PS-50**

You are now ready to make the following connections:

- (Optional) Keyboard, monitor, and mouse
- (Optional) Fiery NX Station furniture

**Note:** The Fiery NX Station furniture kit includes documentation for assembling the furniture.
• Power cable
• Network cable (upper RJ-45)
• Printer interface cable

For more information on connecting cables, see page 34.
Figure 2: Front and connector panel

A  Front panel
  1  Fiery QuickTouch LCD
  2  Type A USB 3.0 ports (x3)
     **Note:** Do not use the USB ports on the Fiery QuickTouch for keyboard/mouse connections for the service purpose.
  3  Fiery QuickTouch reset button
  4  Power button
  5  Front panel door

B  Connector panel
  6  Power connector
  7  Power switch
     | Power On
     O: Power Off
  8  Type A USB 2.0 ports (x2)
  9  Network port (Upper RJ-45)
 10  Display port (for optional monitor)
 11  DVI port (for optional monitor)
 12  Type A USB 3.0 ports (x2)
 13  Printer interface port
Figure 3: Inside the front panel

1. DVD drive
2. DVD eject button
(Optional) Connecting the monitor, keyboard, mouse, and power

Before using the PS-50, connect the monitor, keyboard, mouse, and power to the PS-50 if applicable. The Fiery NX Station is an option.

To connect the monitor, keyboard, mouse, and power

Note: For detailed information about the monitor, keyboard, and mouse, see the documentation that accompanies those products.

1. Make sure that the PS-50 is installed in the furniture and that the monitor is securely attached to the top of the PS-50.

   For more information, see the assembly instructions that accompany the furniture.

2. Connect the monitor cable to the DVI port or Display port on the connector panel.

3. Connect the monitor power cable to an outlet of the power strip inside the furniture, or an outlet on the wall.

4. Place the keyboard and mouse on the furniture table top.

5. Connect the wireless adapter for the keyboard and mouse to one of the USB ports.

   Use the USB ports that is attached at the front of the furniture.

6. Power on the mouse by using the power switch on the bottom side of the mouse.

7. Connect the recessed end of the PS-50 power cable to the power connector on the power strip inside the furniture.

   Be sure to use the appropriate power cable for your regional outlet type.

Connecting to the printer and the network

Connect the PS-50 to the printer and the network to enable print and network connectivity.

To connect to the printer

1. Make sure that the PS-50 and the printer are powered off.

2. Locate the printer interface cable.

3. Connect the printer interface cable from the printer to the printer interface port on the back of the PS-50 (see page 18).

To connect to the network

1. Make sure that the PS-50 is powered off.

2. Make sure that the network cable is connected to the customer site network.
3 Connect the network cable to the upper RJ-45 network port on the back of the PS-50 (see page 18).

The PS-50 provides twisted pair connectivity to an Ethernet network. When the network cable is connected, the Ethernet interface automatically detects the speed of the network environment. Depending on your network speed, the following unshielded twisted pair (UTP) network cables are supported:

- 10BaseT: Category 3 or higher
- 100BaseTX: Category 5 or higher (4-pair/8-wire, short-length)
- 1000BaseT: Category 5e or higher (4-pair/8-wire, short-length)

After power on, the network administrator should perform Network Setup, verify the network connection, verify that the PS-50 appears in the list of printers, and then print a few test documents from a networked computer that will use the PS-50. For more information, see Configuration and Setup, which is part of the user documentation set.

Starting the PS-50 for the first time

This section describes how to start the PS-50 for the first time after connecting the cables.

To start the PS-50

1 Make sure that the power cable is attached and that the power switch on the back of the PS-50 is in the ON position (|).

**Figure 4:** PS-50 power switch

2 Press the power button (圆形) on the side of the Fiery QuickTouch panel.

Press once and release the button to power on the system. The power supply automatically senses the correct voltage.

**Figure 5:** PS-50 power button
3 Check the activities on the Fiery QuickTouch.

The power supply automatically senses the correct voltage. Allow the startup to proceed without interruption. Do not press any buttons while the system is starting.

Configuring a static IP address for the PS-50

If the customer requires the PS-50 to be configured with a static IP address (for example, in a non-DHCP network environment), obtain a valid static IP address from the network administrator and configure the PS-50.

**To configure a static IP address for the PS-50**

1 On the Fiery QuickTouch Home screen, press the Quick launch icon on the bottom-left corner.

2 Select Settings, and log in to the server as Admin user (the default password is Fiery.1).

3 Select Configure IP Address, and select IP Address, DNS, Subnet Mask, WINS, and Default Gateway, as necessary.

4 Save the settings and exit.

Completing the installation

To complete the installation of the PS-50 at the customer site, do the following:

1 Print the Test Page and Server Configuration page (see “Printing PS-50 pages from the monitor, keyboard, and mouse” on page 23).

2 Ask the customer to verify the output.

3 Perform any required system upgrades. For instructions, see the documentation that accompanies the system upgrade.

4 Ask the site administrator to perform Setup and print some test documents over the network.

5 Store the output and the current Server Configuration page(s) near the printer.

6 After the site administrator completes Setup, use the Fiery System Installer to copy the contents of the PS-50 hard disk drive to an image file.

   Fiery System Installer is provided in System Software DVD 1. For detailed instructions, see “Using Fiery System Installer” on page 83.

7 Inform the site administrator that PS-50 user software must be installed on networked computers that print to the PS-50.

8 Ask the site administrator to make sure that all media shipped with the PS-50 is stored in a safe location, accessible to you.

9 For additional installation instructions, see the service documentation that accompanies the PS-50.
Using the PS-50

The following user interfaces are available for the PS-50:

- Fiery QuickTouch on the front of the PS-50.
  
  Fiery QuickTouch is the seven-inch LCD color touch screen interface for the PS-50.

- Fiery NX Station, including a monitor, keyboard, and mouse.

- The printer control panel.

Fiery Ticker

When you log on to the PS-50 using the monitor or Remote Desktop Connection, Fiery Ticker automatically starts showing the status bar.

**Figure 6:** Fiery Ticker status bar

You can perform the following tasks using the Fiery Ticker:

- Monitor the activities of the PS-50 and printer using the Fiery Notes.

- Manage the PS-50 by using Command WorkStation or WebTools.

- Shut down, restart, or reboot the PS-50.

For details, see the Fiery Ticker Help. To access the Fiery Ticker Help, click “>>” icon at the upper left corner of the screen, and select Help.

Printing PS-50 pages from the monitor, keyboard, and mouse

This section describes how to print the Test Page, Server Configuration page, and other Fiery pages.

- **Test Page** verifies that all components of the PS-50-to-printer interface work. The Test Page is a color file that resides on the PS-50 hard disk drive.

  **Note:** Information regarding Test Page refers to PS Test Page or PCL Test Page. For more information, see *Configuration and Setup*, which is part of the user documentation set.

- **Server Configuration page** provides general information about the hardware and software configuration of the PS-50, the customer’s current settings for Setup, the current calibration, and the IP address of the PS-50.

  Printing the Server Configuration page can be helpful during installation, Setup, and service. After installing the PS-50 (including connecting to the network) and before default settings are changed in Run Setup, you can obtain a record of the defaults by printing the Server Configuration page.
To print PS-50 pages

1. At Fiery Ticker screen, click “>>” icon on the upper left corner, and choose Print Pages.
   The Print Pages sub-menu displays the list of available PS-50 pages.

2. Choose the page that you want to print from the sub-menu.
   The PS-50 sends the selected page to the printer.

3. If you printed the PS-50 Test Page, examine the quality of the Test Page from the printer.
   If the Test Page prints, you know the PS-50 is functional and the connection between the PS-50 and the printer is working. If the Test Page fails to print, look up printing problems in “Table 4: PS-50 error messages and condition” on page 102.
   When you examine the Test Page, keep in mind the following:
   - All color patches should be visible, even though they may be very faint in the 5% and 2% range.
   - Each color’s patch set should show uniform gradation from patch to patch as the color lightens from 100% to 0%.
   Poor image or color quality may indicate a need to calibrate the system or service the printer. Information on the Test Page includes the date and time of the last calibration so the Test Page can be kept for future reference. For more information, look up printing problems in “Table 4: PS-50 error messages and condition” on page 102, or see Color Printing, which is part of the user documentation set.

Command WorkStation

As an PS-50 service technician, you will typically log on to the system as Administrator. For more information about using Command WorkStation, see Command WorkStation Help.

About Configure

You can access Configure from Command WorkStation or WebTools. For information about using Configure, see the Command WorkStation Help.

To access Configure from an Internet browser

1. Start a web browser and access the PS-50 by entering the server name or IP address of the PS-50.

   **Note:** If a message about an untrusted connection appears or you are asked whether you want to proceed, you can safely ignore the message and proceed by clicking Continue to website.

2. In WebTools, click the Configure tab on the left side.

3. Log on with Administrator privileges.
To access Configure from Command WorkStation

1. In Command WorkStation, as Administrator, do one of the following:
   - From the Server menu, click Configure.
   - From the SERVERS list, right-click the PS-50 and select Configure.
   - In Device Center, on the General Info tab, click Configure in lower right corner.

2. If the Fiery Setup dialog box displays, click Configure.

Using the PS-50 on Fiery QuickTouch

The Fiery QuickTouch on the front of the PS-50 allows you to do the following:

- View print job status and alerts
- Use Fiery System Restore to back up and restore the PS-50
- Replace the motherboard (when the motherboard replacement dongle is inserted into a USB port)
- View the IP address of the PS-50
- Shut down, restart, or reboot the PS-50 (see page 31).
- Interact with the PS-50 during software installation and initial setup (see page 88)
- Run certain diagnostics (for service purposes only)

**Figure 7:** Fiery QuickTouch

1. Touch panel
2. Power button
3. USB 3.0 ports
4. Fiery QuickTouch reset button (requires pin)
Overview of Fiery QuickTouch options

The following options are available from the Fiery QuickTouch:

**Figure 8:** Fiery QuickTouch Home screen

The Home screen is the main interface for job status, and displays various screen elements.

1. **PS-50 name and status**
   Pressing the Fiery icon shows more information about the PS-50 and the network address.

2. **Icon of the print job type**
   If there are no print jobs being processed, an Idle status displays.

3. **Printing progress of the active print job**

4. **File name of the active print job**

5. **Time left to complete the active print job**

6. **Number of pages and copies that are printing**

7. **Queued jobs list**
   Pressing the Queue icon shows a list of jobs that are queued.

8. **Printed jobs list**
   Pressing the Printed icon shows the printed jobs list.

9. **Quick Launch**
   The Quick Launch displays additional applications.

10. **Shows consumables**

11. **Quick Options and current local time**

The Queue job list shows queued jobs and detailed information about each job.
The Printed jobs list provides job status and details about the jobs that have been printed.

In either the Queue jobs or Printed jobs screen, you can press Back to go back to the Home screen.
**Quick Launch**

From the Home screen, you can press the Quick launch icon on the bottom-left corner of the screen to access the following menus:

- Fiery System Restore
- Settings
- About Fiery
- Print configuration
- Diagnostics (The Diagnostics application icon appears when you insert a diagnostics DVD.)
- Motherboard replacement (The Motherboard replacement application icon appears when you insert the motherboard replacement dongle.)

**Figure 11:** Quick launch menu

Pressing the Home icon takes you back to the Home screen. Before accessing Fiery System Restore or Settings, you must log in as an administrator.

For more information on backing up and restoring the PS-50, see “Using Fiery System Restore” on page 81.

**Quick options**

The Quick Options menu can be accessed by pressing the three-dot icon on the top-right corner of the Home screen. Quick Options provide the following general system settings:

- Shutdown system: shuts down all Fiery server software and powers off the system.
• Reboot system: shuts down all Fiery server software and reboots the system.
• Restart Server: resets the Fiery server software, but does not reboot the entire system.
• Brightness: sets the brightness level of the Fiery QuickTouch screen.

Figure 12: Quick options menu

Using the PS-50 on the printer control panel
You can access the PS-50 from the printer control panel.

To access the PS-50 from the printer control panel
1 At the printer control panel, press the Fiery icon.
2 Login to the PS-50 as Administrator user.
   
   The default password for the Administrator is **Fiery.1** (case-sensitive).
Network status LEDs

Two LEDs next to the network connector indicate the network link status and speed. For additional information about network setup, see *Configuration Guide*, which is part of the user documentation set.

**Figure 13:** Ethernet network port (upper RJ-45)

1. Link/Activity LED
2. Speed LED

**Table 1:** Network link indicators

<table>
<thead>
<tr>
<th>LINK/ACTIVITY LED</th>
<th>Network link status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No link to network</td>
</tr>
<tr>
<td>Solid green</td>
<td>Valid link to network</td>
</tr>
<tr>
<td>Flashed green</td>
<td>Data transfer is in progress</td>
</tr>
</tbody>
</table>

**Table 2:** Network speed indicators

<table>
<thead>
<tr>
<th>SPEED LED</th>
<th>Network speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>10 Megabits/second</td>
</tr>
<tr>
<td>Solid green</td>
<td>100 Megabits/second</td>
</tr>
<tr>
<td>Flashed green</td>
<td>1000 Megabits/second</td>
</tr>
</tbody>
</table>
Starting, shutting down, restarting, and rebooting

You can leave the PS-50 ON all of the time. Remember that when the PS-50 is powered off, network access to the printer is interrupted. Power off the PS-50 when you need to service it and before you remove or attach any cables to it.

⚠️ **Important:** Unless instructed otherwise by a troubleshooting procedure, always shut down the PS-50 from the Fiery QuickTouch or from the monitor attached to the PS-50. Do not use the power button on the side to shut down the PS-50.

**To start the PS-50**

1. Make sure that the power cable is attached and that the power switch on the back of the PS-50 is in the ON position (ON).

   ![Figure 14: PS-50 power switch](image)

2. Press the power button ( ) on the side of the Fiery QuickTouch panel.

   Press once and release the button to power on the system. The power supply automatically senses the correct voltage.

   ![Figure 15: PS-50 power button](image)

3. Check the activities on the Fiery QuickTouch.

   The power supply automatically senses the correct voltage. Allow startup to proceed without interruption. Do not press any buttons while the system is starting.

**To shut down, restart, or reboot from the monitor**

**Note:** The Fiery NX Station (including monitor) is optional.

1. Make sure that the PS-50 is not receiving, processing, or printing any files.

   If the system just finished processing, wait at least five seconds after the system reaches Idle before you proceed.
2 Close all applications except Fiery Ticker.

3 Do one of the following:
   - Click the Windows Start button and then click Power > Shut down.
   - Click the Windows Start button, and then click Power > Restart.
   - Click “>>” icon at the upper-left corner of the screen, and then click Server Actions > Restart Fiery or Reboot Fiery. Click OK.

4 If you shut down the PS-50, move the PS-50 power switch to the off (O) position for maximum energy savings or service (wait 10 seconds before you proceed).

**To shut down, restart, or reboot from the Fiery QuickTouch**

*Note:* Notify the network administrator before you remove the PS-50 from the network.

1 Make sure that the PS-50 is not receiving, processing, or printing any jobs.

   If Printing appears on the Fiery QuickTouch, the PS-50 is processing. You must wait until the system finishes and reaches Idle before restarting or shutting down.

   If the system has just finished processing, wait at least five seconds after the system reaches Idle before beginning the shutdown procedure.

2 On the Fiery QuickTouch Home screen, press the Quick Options.

3 Make a selection.
   - To restart or reboot the PS-50, press Restart server or Reboot system, respectively.
   - To shut down the PS-50 immediately, press Shutdown system.

   Allow the system to shut down and power off or restart.

   If you press Restart server, you may need to wait one minute or more for the server software to restart.

Before accessing internal components following a shutdown, make sure that all cables are disconnected from the back of the PS-50.

**To shut down, restart, or reboot from the printer control panel**

*Note:* Notify the site administrator before you remove the PS-50 from the network.

1 Make sure that the PS-50 is not receiving, processing, or printing any jobs.

   If Printing appears on the Fiery QuickTouch, the PS-50 is processing. You must wait until the system finishes and reaches Idle before restarting or shutting down.

   If the system has just finished processing, wait at least five seconds after the system reaches Idle before beginning the shutdown procedure.

2 Press the Home button on the printer control panel.
3 From the Home screen of the printer control panel, press the Fiery icon.

4 Press Info > Server tab.

5 On the Server tab, press Reboot Server.

6 If prompted, log in as Administrator.

   The default password is **Fiery.1** (case-sensitive).

7 At the next screen, select one of the following options:

   - **Restart Server (soft reset)**—Resets the PS-50 server software but does not reboot the entire system. Network access to the PS-50 is temporarily interrupted and all currently processing jobs are aborted and may be lost. If you choose this option, you may need to wait 1 minute or more for the server software to reset.
   
   - **Reboot System (hard reset)**—Shuts down all PS-50 activity properly and then reboots. Network access to the PS-50 is temporarily interrupted and all currently processing jobs are aborted and may be lost.
   
   - **Shut Down System**—Shuts down all PS-50 server software and powers off the system. You should always select this option when you want to power off the system. Network access to the PS-50 is terminated and all currently processing jobs are aborted and may be lost.

   **Note:** Use the reset button on the front of the PS-50 only if the system is unresponsive to keyboard or mouse actions.
Replacing parts

Generally, the PS-50 requires no regular service or maintenance. Use the procedures in this chapter to inspect, remove, reseat, and replace major hardware components.

Overview

This chapter includes information about servicing the following components:

- Boards and cables
- Fiery QuickTouch display module
- Motherboard components (DIMMs, CPU, and battery)
- Fan
- Power supply
- Hard disk drive
- DVD drive

Replacement parts are available from your authorized service representative. The terms “replace” and “replacing” are used throughout this document to refer to the reinstallation of existing components. Install new components only when necessary. If you determine that a component that you have removed is not faulty, reinstall it.

**Note:** Replacement parts and specifications are subject to change. Install the correct parts as directed by your service/support center.

⚠️ **Caution:** When servicing the PS-50, follow the precautions listed on page 9.

For a list of the tools required to service the PS-50, see page 9.

For information about the monitor, keyboard, and mouse, see the documentation that accompanies those products.
PS-50 hardware

**Figure 16:** Front and connector panel

<table>
<thead>
<tr>
<th>A</th>
<th>Front panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fiery QuickTouch LCD</td>
</tr>
<tr>
<td>2</td>
<td>Type A USB 3.0 ports (x3)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Do not use the USB ports on the Fiery QuickTouch for keyboard/mouse connections for the service purpose.</td>
</tr>
<tr>
<td>3</td>
<td>Fiery QuickTouch reset button</td>
</tr>
<tr>
<td>4</td>
<td>Power button</td>
</tr>
<tr>
<td>5</td>
<td>Front panel door</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>Connector panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Power connector</td>
</tr>
<tr>
<td>7</td>
<td>Power switch</td>
</tr>
<tr>
<td></td>
<td>Power On</td>
</tr>
<tr>
<td></td>
<td>Power Off</td>
</tr>
<tr>
<td>8</td>
<td>Type A USB 2.0 ports (x2)</td>
</tr>
<tr>
<td>9</td>
<td>Network port (Upper RJ-45)</td>
</tr>
<tr>
<td>10</td>
<td>Display port (for optional monitor)</td>
</tr>
<tr>
<td>11</td>
<td>DVI port (for optional monitor)</td>
</tr>
<tr>
<td>12</td>
<td>Type A USB 3.0 ports (x2)</td>
</tr>
<tr>
<td>13</td>
<td>Printer interface port</td>
</tr>
</tbody>
</table>
Figure 17: Inside the front panel

1. DVD drive
2. DVD eject button
**Figure 18:** Exploded view of components

1. Fiery QuickTouch USB3.0 cable
2. Hard disk drive data cables
3. DVD drive data cable
4. Printer interface board
5. Fiery QuickTouch power cable
6. CPU cooling assembly
7. DIMM (x2)
8. CPU
9. Battery
10. Motherboard
11. Front panel
12. Power supply
13. Hard disk drive
14. DVD drive
15. Chassis
16. CPU fan
17. Fiery QuickTouch display
18. Top panel

**Note:** CPU fan cable, tie-wraps, cable clamps, dongle(s), and external cables are not shown.
Figure 19: Power and data cable connections

<table>
<thead>
<tr>
<th>Cable key</th>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power supply cable</td>
<td>Power supply</td>
</tr>
<tr>
<td></td>
<td>a. 24-pin power connector on motherboard (J18)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. 8-pin power connector (PWRCONN1)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. DVD drive power connector</td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. Hard disk drive power connector</td>
<td></td>
</tr>
<tr>
<td></td>
<td>e. Fiery QuickTouch power connector</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Fiery QuickTouch USB cable</td>
<td>USB3.0 header connector on motherboard (J26)</td>
</tr>
<tr>
<td>3</td>
<td>SATA Data cable</td>
<td>DVD drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SATA 0 connector on motherboard (J50)</td>
</tr>
<tr>
<td>4</td>
<td>SATA Data cable</td>
<td>Hard disk drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SATA 1 connector on motherboard (J41)</td>
</tr>
<tr>
<td>5</td>
<td>Rear fan cable</td>
<td>Rear fan</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FRONT FAN connector on motherboard (J20)</td>
</tr>
<tr>
<td>6</td>
<td>CPU fan cable</td>
<td>CPU fan</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CPU FAN connector on motherboard (J16)</td>
</tr>
<tr>
<td>7</td>
<td>Power switch cables (red, white)</td>
<td>Fiery QuickTouch</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FP header connector (pin 6, 8) on motherboard (J15)</td>
</tr>
<tr>
<td></td>
<td>Align triangle on cable connector as shown.</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>LED cables (white, black)</td>
<td>Fiery QuickTouch</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FP header connector (pin 2, 4) on motherboard (J15)</td>
</tr>
</tbody>
</table>

Note: See the cable connection label attached inside the chassis.
Accessing internal components

Shut down and open the PS-50 when you need to inspect or service internal components.

Shutting down the system

If the PS-50 is powered on, you must shut down the system before you access the internal components. See “Starting, shutting down, restarting, and rebooting” on page 31.

When shutting down the PS-50, do the following:

⚠️ **Important:** Remember that when the PS-50 is powered off, network access to the printer is interrupted. Always obtain permission from the network administrator before you take the PS-50 off the network.

- Remove the power cable from the connector panel before removing or connecting interface cable or accessing the internal components.
- If you are cycling power, wait at least 10 seconds before powering back on.
- If you are unable to shut down the PS-50 through the Fiery QuickTouch, power off by holding down the power button on the side of the PS-50 for up to eight seconds.

Opening the PS-50

Before you open the PS-50, it is strongly recommended that you review “Precautions” on page 9 to avoid injury or damage to the PS-50.

When you handle electronic components, follow electrostatic discharge precautions (see page 11).

To open the PS-50

1. Shut down the PS-50 (see page 39).
2. Wait 10 seconds after the PS-50 powers off, and then remove all cables from the back of the PS-50.
3. Remove the PS-50 from the furniture, if applicable.
4. Remove all external panels necessary to access the component that you need to service.

At the minimum, you must remove the left panel to service the component. You may also need to remove other panels, depending on the component that you need to access. For guidelines on which panels to remove, see the service procedures that accompany a given component.

**Note:** When removing multiple panels from the PS-50, use the following order:

- Left side panel (see page 40)
- Right side panel (see page 40)
- Front panel (see page 41)
- Top panel with Fiery QuickTouch (see page 42)
5 Place the PS-50 on a flat surface. Carefully position the PS-50 so that it is standing in its normal position.

To remove the side panels

1 Remove the two screws at the rear right of the chassis.

Figure 20: Removing the left panel

2 From the back of the unit, slide the right side chassis cover toward the rear of the unit and remove.

3 Remove the two screws at the rear left of the chassis.

Figure 21: Removing the right panel

4 From the back of the unit, slide the left side chassis cover toward the rear of the unit and remove.
To remove the front panel

1. Remove the anchor screw from the front bezel.

**Figure 22:** Front bezel anchor screw

2. Release the six tabs and pull the front bezel off.

**Figure 23:** Front bezel tabs

1. Top tab (one on each side of bezel)
2. Middle tab (one on each side of bezel)
3. Bottom tab (one on each side of bezel)

To replace the chassis panels

1. Attach the front bezel to the front of the unit snapping tight the six tabs. See Figure 23.
2. Insert the anchor screw to secure the front bezel. See Figure 22.
3 Slide the right chassis cover into place and secure with two screws on backside of the unit.

4 Slide the left chassis cover into place and secure with two screws on backside of the unit.

Fiery QuickTouch display module

Fiery QuickTouch is attached to the top panel of the PS-50.

Follow the directions to remove the chassis covers. See “Opening the PS-50” on page 39. You will need to remove the side covers, then the front cover before you will be able to release the top bezel with the Fiery QuickTouch attached.

⚠️ Caution: It is highly recommended that you use a screwdriver with a magnetic tip when removing or replacing screws on the Fiery QuickTouch. If you do not, the screws you remove or replace might fall inside the Fiery QuickTouch device.

To remove the Fiery QuickTouch

1 Follow the instructions to remove the side and front chassis covers.

2 To remove the top bezel, slide the bezel forward and release it from the top of the chassis.
3 Stabilize the unit and set the Fiery QuickTouch on its side atop the unit.

4 Remove the two connectors attached to the Fiery QuickTouch.
   
   a Remove the tie-wrap that bundles the power cable and a tab on the support bracket for USB connector.
   
   b Remove the power harness by unplugging it.
c Remove the two screws from the USB connector and then unplug the connector.

⚠️ **Caution:** Use a screwdriver with a magnetic tip so you do not drop a loose screw into the Fiery QuickTouch unit.

5 Turn the unit so it is faced down on the work surface.
6 Remove the single screw in the center, then remove the washer and spring washer.

7 Rotate the Fiery QuickTouch 45 degrees.

8 Remove the top bezel.

**Replace the Fiery QuickTouch**

1 Attach the new Fiery QuickTouch part to the top bezel by rotating the top bezel 45 degrees, then rotate until the bezel and Fiery QuickTouch align. Insert the spring washer, then the screw with washer and tighten.

2 Once attached, ensure that the Fiery QuickTouch moves properly from side to side.

3 Place the top bezel with Fiery QuickTouch atop the unit on its side.

4 Plug in the USB cable and insert the plug so that the mark on the cable and mark on the internal board line up.

5 Insert the two screws to secure the plug and grounding bracket.

   **Caution:** Use a screwdriver with a magnetic tip so you do not drop a loose screw into the Fiery QuickTouch unit.

6 Insert the power harness and loop it around guides to allow the Fiery QuickTouch to move freely.

7 Use a tie-wrap to secure the power cable to the tab on the supporting bracket for USB connector.

8 Replace the top bezel on top of the unit and slide back in place.
9 Check that the bezel cover extends over the rear sheet metal to be properly in place.

10 Replace the chassis panels (see page 41).

11 If you replaced the Fiery QuickTouch with a new one, install the Fiery QuickTouch software (see page 91).

Removing and replacing boards

This section includes procedures for removing and replacing the following boards:

- Printer interface board
- Motherboard

The PS-50 is shipped from the factory with a standard board configuration. If optional components have been installed, see the documentation that accompanies the particular option kit.

**Printer interface board**

The printer interface board provides the print interface between the PS-50 and the printer. It is installed in PCIE x16 slot on the motherboard. The printer interface board processes the image data and sends it to the printer through the printer interface cable.

![Diagram of Printer interface board]

**To remove the printer interface board**

When you handle electronic components, follow electrostatic discharge precautions (see page 9).

1 Shut down and open the PS-50 (see page 39).

   To remove the printer interface board, you must remove the left panel.

2 Remove the printer interface cable that connect the printer interface board and the printer.

3 Remove the board mounting bracket screw that attaches the printer interface board to the chassis.
4 Remove the printer interface board from the chassis.
   Grasp the printer interface board at the front and back edges and gently pull the board straight out of its motherboard connector.

5 Place the printer interface board in an antistatic bag.

To replace the printer interface board

When you handle electronic components, follow electrostatic discharge precautions (see page 9).

1 Insert the board into the PCIE x16 connector on the motherboard (see Figure 25 on page 50).
   The component side of the interface board must face down, toward the base of the chassis. The interface board connector is keyed to fit only one way. When reseating the board, be careful to not disturb any motherboard cables that are installed nearby.

2 Secure the board to the chassis with the board mounting bracket screw that you removed earlier.

3 Reassemble the PS-50 and verify its functionality (see page 75).

Motherboard

⚠️ **Important:** If you are removing the motherboard in order to replace it with a new motherboard, review the troubleshooting and motherboard cautions on page 52.

The CPU mounted on the motherboard controls the image data transferred to and from the printer interface board. The motherboard also controls hard disk drive functions and the communication between the PS-50 and external devices.
### Motherboard replacement overview

You suspect a faulty motherboard or hard disk drive.

1. Replace the hard disk drive.  
   - See page 69
2. Reinstall system software.  
   - See page 88
3. **Problem solved?**
   - Yes. Reassemble system and verify functionality.
   - No. Reinstall old hard disk drive.  
     - See page 69
4. Replace the motherboard.  
   - See page 52
   - Connect the motherboard replacement dongle.
5. **Enter Service Mode and verify the new motherboard installation.**  
   - See page 55
   - **Are test pages printed successfully?**
     - Yes. Transfer options and BIOS information to the new motherboard.  
       - See page 56
     - No. Reinstall the old motherboard. Return the new motherboard and dongle to inventory.

### Removing the motherboard

The motherboard attaches to the side of the chassis, below the power supply. Before you remove the motherboard, you must remove the following:

- All boards installed on the motherboard
• All cables connected to the motherboard

  (including the motherboard power cable, CPU power cable, rear fan cable, hard disk drive data cable, DVD drive power and data combination cable, power/LED cable, and Fiery QuickTouch USB port cables)

This section also includes information about the following:

• Replacing or adding DIMMs
• Replacing the CPU
• Replacing the battery
• Jumper configurations

⚠️ **Important:** Follow standard ESD and other safety precautions when handling components (see page 9). During service to the motherboard, avoid using excessive force and always place the motherboard on a grounded, non-metallic, static-free surface. Never allow any metal to touch the solder contacts on the underside of the motherboard, especially beneath the battery socket. Improper handling can short-circuit and permanently damage the motherboard.
### Figure 25: Motherboard

<table>
<thead>
<tr>
<th>1</th>
<th>Type A USB 2.0 ports and network port</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Monitor port (DisplayPort)</td>
</tr>
<tr>
<td>3</td>
<td>Monitor port (DVI)</td>
</tr>
<tr>
<td>4</td>
<td>Type A USB 3.0 ports (x2)</td>
</tr>
<tr>
<td>5</td>
<td>8-pin power connector (PWRCONN1)</td>
</tr>
<tr>
<td>6</td>
<td>CPU cooling assembly</td>
</tr>
<tr>
<td>7</td>
<td>Printer interface board (PCIE_X16_SLOT)</td>
</tr>
<tr>
<td>8</td>
<td>Battery (XBT1)</td>
</tr>
<tr>
<td>9</td>
<td>DIMM0 (A1)</td>
</tr>
<tr>
<td>10</td>
<td>DIMM1 (B1)</td>
</tr>
<tr>
<td>11</td>
<td>CPU fan power (CPU FAN)</td>
</tr>
<tr>
<td>12</td>
<td>Rear fan (FRONT FAN)</td>
</tr>
<tr>
<td>13</td>
<td>24-pin power connector (J18)</td>
</tr>
<tr>
<td>14</td>
<td>Fiery QuickTouch USB ports (J26)</td>
</tr>
<tr>
<td>15</td>
<td>Power switch and LED (J15)</td>
</tr>
<tr>
<td>16</td>
<td>SATA 0, DVD drive data connection</td>
</tr>
<tr>
<td>17</td>
<td>SATA 1, Hard disk drive data connection</td>
</tr>
<tr>
<td>18</td>
<td>Clear CMOS Jumper (J4)</td>
</tr>
</tbody>
</table>

**Note:** Arrows indicate positions for inserting cable and jumper connections.

### To remove boards and cables from the motherboard

1. Shut down and open the PS-50 (see page 39).
   
   To access the motherboard, you must remove the left side panel.

2. Remove the printer interface board installed in the PCIE x16 slot on the motherboard.
3 Remove the following cables from the old motherboard:

   **Note:** First remove any plastic cable clamp(s) securing internal cables and tie-wraps.

   - Rear fan cable
   - Fiery QuickTouch power/LED cable
   - Fiery QuickTouch USB port cable
   - DVD drive cables:
     - SATA data cable
     - Power and data combination cable
   - Hard disk drive cables:
     - SATA data cable
     - Power supply cable
   - 24-pin motherboard power cable
   - 8-pin motherboard power cable
   - CPU fan cable
   - In-line spectrophotometer cable

   For motherboard connector locations, see page 48.

**To remove the motherboard**

   **Note:** This procedure assumes that you have already performed the procedure “To remove boards and cables from the motherboard” on page 50.

1 Remove all the mounting screws securing the motherboard to the chassis (for screw locations, see Figure 25 on page 50).

2 Remove the motherboard from the chassis.

   Lift the edge of the motherboard. Make sure that the motherboard connectors clear the chassis while you lift it out of the chassis. Do not touch the contacts and avoid using excessive force.

   **Important:** During service, avoid using excessive force and always place the motherboard on a grounded, non-metallic, static-free surface. Never allow any metal to touch the solder contacts on the underside of the motherboard, especially beneath the battery socket. Improper handling can short-circuit and permanently damage the motherboard.

3 If you are replacing the motherboard with a new motherboard, remove the following from the old motherboard:

   - DIMMs (see page 58)
   - CPU (see page 59)
Replacing the motherboard

⚠️ **Important:** Follow the procedures in this section to replace the motherboard. Failure to follow the instructions in this section may corrupt the system (not easily repaired in the field) or result in an incomplete installation.

**Troubleshooting cautions**

- Before deciding to install a new motherboard, consult “Troubleshooting” on page 96.

- Inspect all cables and internal components as described on pages “Checking external connections” on page 96 and “Checking internal components” on page 97.

- If troubleshooting strategies (checking cables and connections, reinstalling system software, and so forth) do not solve the problem, and you suspect that the hard disk drive or the motherboard is faulty, always troubleshoot in the following order.

⚠️ **Important:** Troubleshooting in the wrong order will cause the system to malfunction. In general, it is highly unlikely that both the hard disk drive and the motherboard are defective; therefore, avoid replacing both to solve one problem.

- **First**, replace the hard disk drive and install system software.
  
  Always replace a faulty hard disk drive with a new hard disk drive. Transferring a hard disk drive from one PS-50 to another is incorrect and strongly discouraged.

- **If the problem persists**, reinstall the original hard disk drive in the system, and then replace the motherboard.

**Motherboard cautions**

⚠️ **Important:** If you have exhausted all other troubleshooting remedies and determined that you need to install a new motherboard, be sure to observe the following cautions:

- **Do not transfer the BIOS chip from the old motherboard onto the new motherboard.**
  
  BIOS chips are not interchangeable.

- **Do not reinstall system software at this time.**
  
  Reinstalling system software is not necessary when installing a new motherboard and can result in an error if done before transferring options to the new motherboard (described on page 56.)
• Before you use the motherboard replacement dongle to sync the BIOS and options (for example, Fiery Graphic Arts, Premium Edition, if applicable) from the hard disk drive to the new motherboard, enter Service Mode (see page 56) and make sure that the new motherboard solves the problem that you are troubleshooting.

The PS-50 can remain in Service Mode indefinitely. Use Service Mode to carefully verify the new motherboard before transferring options to the new motherboard.

Transferring options to the new motherboard permanently customizes the new motherboard. Once customized, the motherboard cannot be returned to inventory or installed in another PS-50. If the new motherboard does not solve the problem in Service Mode, do not transfer options. Return the new motherboard and motherboard replacement dongle to inventory.

• If you can verify in Service Mode that the new motherboard solves the problem that you are troubleshooting, transfer options to the new motherboard using the motherboard replacement dongle included with the new motherboard (see page 56).

• Do not remove the motherboard replacement dongle while transferring options to the new motherboard.

Removing the motherboard replacement dongle prematurely will corrupt the dongle and possibly damage the motherboard. If either become corrupted, you must contact your authorized service/support center and order a new replacement motherboard kit.

To replace the motherboard

1 If you are installing a new motherboard, do the following:

• Unpack the new motherboard.

• Open the load plate covering the CPU socket (see page 61) and remove the protective plastic cover on the CPU socket on the new motherboard. Later, you will transfer the protective plastic cover to the CPU socket of the old motherboard to protect the circuitry.

• Remove the DIMMs from the old motherboard and install them on the new motherboard (see page 58).

• Remove the CPU and cooling assembly from the old motherboard and install them on the new motherboard (see page 59). Make sure that the cable cover (if present) remains on the cooling assembly fan cable when transferring the cooling assembly to the new motherboard.

⚠️ Important: When transferring the CPU to the new motherboard, make sure to use the fresh thermal compound that came with the new motherboard. For more information about the thermal compound, see page 62.

⚠️ Important: Do not transfer the BIOS chip from the old motherboard onto the new motherboard. Doing so can damage the PS-50. BIOS chips are not interchangeable.
2 Install the motherboard in the chassis.

- Angle the motherboard so that the motherboard connectors fit into the cutouts in the back of the chassis.
- **Important:** Make sure that the flexible grounding tabs on the cutouts for the network ports make contact with the outside of the ports. Do not allow the tabs to fold over or become bent inside the ports. The ports will not function if the tabs are placed improperly. Take care when lowering the new motherboard into the chassis. Do not strike the motherboard against the metal standoffs attached to the chassis, as doing so can damage the components on the underside of the motherboard.

3 Align the mounting holes on the motherboard with the standoffs located in the base of the chassis.

4 Secure the motherboard to the chassis using all the mounting screws that you removed earlier.

- Partially tighten each screw before completing tightening any one screw. Do not overtight the screws; doing so could damage traces on the motherboard.

You are now ready to complete motherboard installation.

**To replace boards, cables, and components**

1 Replace the hard disk drive bracket, with hard disk drive attached (see page 72).

   You removed the hard disk drive bracket to provide clearance for removing the motherboard.

2 Replace the following cables (see page 50 for the connector locations).

   - CPU fan cable
   - 24-pin motherboard power cable
   - 8-pin motherboard power cable
   - Fiery QuickTouch power/LED cable
   - Fiery QuickTouch USB port cable
   - Hard disk drive cables:
     - SATA data cable
     - Power supply cable
   - DVD drive cables:
     - Power and data combination cable
     - SATA data cable
   - Rear fan cable
   - In-line spectrophotometer

3 Secure cables as necessary with any plastic cable clamp that you may have removed earlier.
4 Replace the printer interface board (see page 50 for the location).

   Make sure to install the board mounting bracket screw to secure the board to the chassis. Press down firmly on the top of the board as you insert the screw.

   **Important:** Make sure that unused connector panel slots are covered with slot covers. Uncovered slots reduce air flow and may cause the PS-50 to overheat.

5 If you reinstall the old motherboard, reassemble the PS-50 and verify its functionality (see page 75).

6 If you replace the motherboard with a new motherboard, do the following:
   - Remove the battery (see page 63).
   - Wait two minutes to allow the motherboard electrical components to fully discharge.
   - Reinstall the battery.
   - Reassemble the PS-50 (see page 75).
   - Reset the time and date in Setup (see Command WorkStation Help for more information).

**Verifying new motherboard installation, and transferring options and BIOS information**

After you install a new motherboard and reassemble the system, do the following:

   - Verify all functionality by using the motherboard replacement dongle to enter Service Mode. (Service Mode is not indicated on the monitor or Fiery QuickTouch panel, but is entered once you power on with a new motherboard installed and the motherboard replacement dongle installed on a USB port.)

   Service Mode is a temporary state that allows you to make sure that the motherboard solves the problem that you are troubleshooting. Service Mode is exited automatically when you expend the motherboard replacement dongle to transfer options to the new motherboard (see “Entering Service Mode” on page 56).

   **Note:** Features of Fiery Impose-Compose are not available while in Service Mode.

   - If the new motherboard solves the problem that you are troubleshooting, use the motherboard replacement dongle to transfer options to the new motherboard.

      If you determine while in Service Mode that the problem you are troubleshooting was not fixed by installing a new motherboard, do not expend the motherboard replacement dongle to transfer options to the new motherboard (described below), do not install system software, and do not replace the hard disk drive. Reinstall the old motherboard and return the new motherboard and the unused motherboard replacement dongle to inventory. You may then perform additional service and troubleshooting procedures.

      Transferring options (for example, Fiery Graphic Arts, Premium Edition, if applicable) expends the motherboard replacement dongle. For details, see “Entering Service Mode” on page 56.

   **Important:** Do not transfer options to the new motherboard prematurely. Do so only after you verify the new motherboard in Service Mode. Remember that once options are transferred to the new motherboard using the motherboard replacement dongle, the motherboard is customized and cannot be used in another system.
Entering Service Mode

Use the following procedure to verify that the system functions properly after installing a new motherboard.

To enter Service Mode and verify the system

Note: This procedure assumes that the PS-50 is powered off, no media is in the DVD drive, you have installed a new motherboard, and that you have reassembled the PS-50 and attached external cables.

1. Make sure the PS-50 is connected to the printer (see page 20).
2. Locate the motherboard replacement dongle provided with the new motherboard and connect it to a USB port.
3. Remove all USB devices (except for the keyboard and mouse) that may be currently connected to any other USB port.
   Reconnect other dongles and USB devices only after you verify that the PS-50 starts up successfully in Service Mode.
4. Power on the PS-50 and allow it to boot without interruption.
   At the log on screen, log in as Admin, type Fiery.1 in the password field, and then press Enter on the keyboard. Type Fiery.1 exactly as shown. The password is case-sensitive; for example, fiery.1 will not work.
   At this point the PS-50 is in Service Mode, so you can verify that the new motherboard solves the problem that you are trying to troubleshoot. Service Mode is not indicated on the monitor or on the PS-50 Fiery QuickTouch.
5. Print the PS-50 Test Page.
6. Ask the network administrator to connect the PS-50 to the network and download a print job over the network (see Configuration and Setup, which is part of the user documentation set).

If the problem that you are troubleshooting persists, or if you are unable to perform steps 4 through step 6 above while in Service Mode, you may conclude that the old motherboard was not the source of the problem and does not need to be replaced. If so, do not transfer options to the new motherboard (described on page 56), do not install system software, and do not replace the hard disk drive. Reinstall the old motherboard and return the new motherboard with the unexpended motherboard replacement dongle to inventory. For more information about troubleshooting system problems, see “Troubleshooting” on page 96.

If installing a new motherboard solved the problem that you are troubleshooting and you are able to print a Test Page and send a print job over the network, you are ready to transfer options to the new motherboard. Service Mode ends automatically when you transfer options to the new motherboard.

Transferring options and BIOS information to the new motherboard

After you verify that the new motherboard solves the problem that you are troubleshooting, you must use the motherboard replacement dongle to transfer options to the new motherboard.

To transfer options and BIOS information to the new motherboard

Note: This procedure, which takes approximately 15-20 minutes, assumes that the PS-50 is fully assembled with the new motherboard, and verified in Service Mode (see page 56).
1 Verify that all power is turned off on the PS-50.

2 Insert the motherboard replacement dongle into a USB port.

3 Turn on the PS-50.
   Wait until the PS-50 reaches Idle.

4 On the PS-50 Fiery QuickTouch, select MB Replacement.
   The Fiery QuickTouch displays “Reading dongle...”, then displays the number of licenses left to apply to the transfer.

5 Select Yes to confirm the license transfer.
   The Fiery QuickTouch displays “Applying” to indicate the transfer of options and the backup BIOS from the hard disk drive to the BIOS chip on the replacement motherboard.
   **Note:** If you select “No” the process ends and you return to the Functions menu.

6 Reboot the PS-50.

7 Remove the motherboard replacement dongle after the PS-50 reaches Idle.
Replacing parts on the motherboard

Before you remove and replace the DIMMs, CPU, and battery on the motherboard, shut down and open the PS-50 (see page 39).

DIMMs

When installing DIMMs, note the following:

- Different capacity DIMMs look alike. Make sure that you know the capacity of each DIMM before you install it in a slot.
- Install only approved DIMMs available from your service representative.
- DIMMs must be installed in matched pairs. A matched pair is comprised of two alternate slots. DIMMs within a pair must be identical (same capacity and same number of chips on each side). For example, in a two-DIMM configuration, populate DIMM 1 and DIMM 2 with DIMMs of identical capacity, with the same number of chips on each side.

To replace a DIMM

1. Shut down, and then open the PS-50 (see page 39).

   To access the DIMMs, you must remove the left panel.

2. Remove the printer interface board from the motherboard (see page 46).
3. To release a DIMM, push the clips outward on each side of the DIMM.

Figure 26: Releasing a DIMM

4. Pull the DIMM straight out of the Slot.

5. To replace a DIMM, insert the DIMM straight into the slot and close the clips at each side to lock it into place.

   **Note:** The slot is keyed so that the DIMM fits only one way. (See the notches in the preceding figure.)

   **Important:** Make sure that the entire length of the DIMM (ends and center) is fully seated in the slot and that the clips close securely around the ends of the DIMM.

6. If you install a new DIMM, make sure to reset the time and date in Setup (see Configure Help for more information).

7. Replace the printer interface board (see page 47).

8. Reassemble the PS-50 and verify its functionality (see page 75).

**CPU**

The CPU is installed in a socket on the motherboard. Before you remove the CPU from its socket, remove the motherboard from the chassis (see page 48), disconnect the CPU fan cable from the motherboard, and then remove the cooling assembly from the PS-50 (see page 60). The CPU cooling assembly consists of a fan and a heatsink.

**Note:** Do not remove the CPU fan from the heatsink.
**Figure 27:** CPU cooling assembly

1. **CPU fan**
2. **Fastener screw (1 of 4)**
3. **Heatsink**
4. **CPU**
5. **Yellow triangle**
6. **Load plate open**
7. **Yellow triangle**

**Important:** If you remove the CPU from the motherboard in order to install it on a new motherboard, unpack the new motherboard and remove the protective plastic cover on the CPU socket. Transfer the protective cover to the CPU socket of the old motherboard to protect the circuitry. Follow standard ESD precautions while handling the motherboard and all components.

**To remove the cooling assembly**

1. Shut down, and then open the PS-50 (see page 39).

   To access the CPU, you must remove the left panel.
2 Remove the CPU fan cable from motherboard connector CPU FAN.

3 Remove the CPU cooling assembly.

⚠️ **Caution:** Be aware that both the cooling assembly and the CPU may be very hot. You may need to allow the components to cool before you attempt to remove them.

- Loosen the four screws that secure the cooling assembly to the motherboard. Partially loosen all the screws before loosening any one screw all the way.
- Lift the cooling assembly off the CPU socket and set it aside.

4 Lift the cooling assembly off the CPU socket and set it aside.

**To remove and replace the CPU**

1 Unlock the CPU socket lever and raise it into the open position (flex the lever away from the retention post, and then raise it).

2 Open the load plate.

3 Grasp the CPU by its edges, lift it out of the socket, and then place the CPU in a safe place.

**Note:** If you remove the CPU from the motherboard to install it on a new motherboard, unpack the new motherboard and remove the protective plastic cover from the CPU socket. Transfer the protective cover to the CPU socket of the old motherboard to protect the circuitry.

4 Wipe the contact surface of the CPU (the smooth, gray side of the chip) with a clean, lint-free cloth to ensure proper contact with the new heatsink.

If you remove the CPU from the motherboard to install it on a new motherboard, make sure that you completely remove any thermal compound residue on the surface of the CPU and at the base of the heatsink. It may help to scrape all the residue off of the surface using the flat edge of something non-conductive.
5 Prepare the CPU socket by ensuring that:
   • The socket lever is in the open position.
   • The load plate is open.

6 Place the CPU in the socket.

   The CPU and the socket are keyed to ensure correct installation. The notches on the edges of the CPU correspond with the two small posts inside the socket. Align the yellow triangle on the CPU with the yellow triangle on the socket. Do not force the CPU.

7 Close the load plate.

8 Lower the socket lever and place it in the locked position under the retention post.

**Figure 28: Removing/replacing the CPU**

---

**To replace the CPU cooling assembly**

**Note:** Before you install the cooling assembly, completely remove any thermal compound residue on the surface of the CPU and the base of the heatsink, and then apply a fresh thermal compound square to the base of the heatsink. When installing the thermal compound square, make sure to remove the plastic backing on both sides of the square. Avoid creating any bubbles or wrinkles on the square. Bubbles and wrinkles reduce the heat-transfer efficiency of the cooling assembly.

1 Prepare the CPU cooling assembly for installation.
   • Make sure that the motherboard is placed on a padded, static-free work surface.
   • Apply a fresh thermal compound square, as described in the note above.
   • Align the cooling assembly so that when it is installed, the fan cable easily reaches the CPU fan power connector CPU FAN on the motherboard.
2 Place the cooling assembly on the CPU.

- Make sure that the thermal pad on the underside of the heatsink is positioned on top of the CPU.

Be sure to remove any protective material that may be covering the surface of the thermal pad. Otherwise the CPU may overheat.

- Align the four screws with the four screw posts.

Tighten the screws. Partially tighten all the screws before tightening any one screw all the way.

3 Connect the CPU fan cable to the motherboard connector CPU FAN.

⚠️ **Important:** If you are installing a new CPU, secure slack in the fan cable using a tie-wrap. The tie-wrap prevents the fan cable from interfering with the CPU fan. Also, make sure the connector on the cable is securely connected to the motherboard.

4 If you installed a new CPU, make sure to reset the time and date in Setup (see Configure Help for more information).

5 Reassemble the PS-50 and verify its functionality (see page 75).

### Battery

The battery on the motherboard is located at XBT1. To replace it, use a 3V manganese dioxide lithium coin cell battery (Sony CR2032 or equivalent).

⚠️ **Warning:** There is danger of explosion if the battery is replaced with an incorrect type. Replace it only with the same type recommended by the manufacturer. Dispose of used batteries according to local regulations.

**ACHTUNG:** Es besteht Explosionsgefahr, wenn die Batterie durch eine Batterie falschen Typs ersetzt wird. Als Ersatz dürfen nur vom Hersteller empfohlene Batterien gleichen oder ähnlichen Typs verwendet werden. Verbrauchte Batterien müssen entsprechend den jeweiligen gesetzlichen Bestimmungen entsorgt werden.

**ATTENTION :** Il y a risque d’explosion si la pile est remplacée par un modèle qui ne convient pas. Remplacez-la uniquement par le modèle recommandé par le constructeur. Débarrassez-vous des piles usées conformément aux réglementations locales en vigueur.

**ADVARSEL:** Litiumbatteri - Eksplosionsfare ved feilagtig håndtering. Batteriet må kun udskiftes med et andet batteri af samme fabrikat og type. Brugte batterier skal bortskaffes i henhold til gældende regler.

**VAROITUS:** Paristo voi räjähtää, jos se on vaihdetaan väärrän tyypiseen paristoon. Vaihda paristo ainoastaan laitevalmistajan suosittelemaan tyyppiin. Hävitä käytetyt paristot asianmukaisesti.

**ADVARSEL:** Eksplosjonsfare ved feilaktig skifte av batteri. Benytt samme batteritype eller en tilsvarende type anbefalt av apparatfabrikanten. Brukte batterier kasseres i henhold til lokal lovgivning.

**WARNING:** Risk för explosion om batteriet byts ut mot en felaktig batterityp! Byt bara ut batteriet mot en batterityp som har godkänns av tillverkaren. Hantera använda batterier enligt lokal miljölagstiftning.
To replace the battery

1. Shut down, and then open the PS-50 (see page 39).
2. Locate the battery on the motherboard (see Figure 25 on page 50).
3. Carefully push the clip away from the battery until the socket ejects the battery.
4. Slide the battery out of its socket.
5. Wait two minutes to allow the motherboard electrical components to fully discharge.
6. To insert a new battery, slide it into the socket so that the positive (+) side of the battery faces up.
7. Press the battery down into the socket until it snaps into place. Make sure that the battery is securely installed in the socket.
8. Reassemble the system and verify its functionality (see page 75).
9. Configure the time and date in Setup (see Configure Help for more information).

⚠️ **Important:** Failure to configure the time and date will cause the PS-50 to hang when user software is being installed on the PS-50.
Jumpers

Jumper configurations should not be changed.

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J101</td>
<td>J4 is the Clear CMOS and Password jumper. Default configuration: jumper cap installed on pins 2 and 3. <strong>Note:</strong> It is not necessary to clear the CMOS settings when servicing motherboard components, the DVD drive, and the hard disk drive.</td>
</tr>
</tbody>
</table>

Fan

A fan mounted inside the PS-50 chassis draws air into the PS-50 to cool components. The fan runs continuously when the system is on. You should hear the fan start as soon as you power on the PS-50. If you do not hear the fan, there may be a faulty power connection.

The following procedures describe how to remove and replace the fan.

**To remove the fan**

1. Shut down, and then open the PS-50 (see page 39).
   - To access the fan, you must remove the left panel.

2. Remove the fan cable from motherboard connector FRONT FAN.
3 Remove the four screws from the connector panel, while holding the fan assembly from the inside. Set aside the screws.

**Figure 30:** Removing/replacing the fan

4 Remove the fan from the chassis.

**To replace the fan**

1 Align the fan with the four holes on the connector panel.

2 Install the four screws you removed earlier to secure the fan assembly to the connector panel.

3 Connect the fan cable to motherboard connector FRONT FAN.

4 Reassemble the PS-50 and verify its functionality (see page 75).
Power supply

This section describes how to remove and replace the power supply. For more information about the power supply, see “Physical specifications” on page 112.

⚠️ **Caution:** Do not open the power supply for service or troubleshooting purposes. Opening the power supply will void the warranty.

**To remove the power supply**

1. Shut down the PS-50, remove all cables from the back, and then open the system (see page 39).

   To remove the power supply, you must remove the left and right panels.

2. Remove the 24-pin power cable from connector J18 on the motherboard.

3. Remove the 8-pin power cable from connector PWRCONN1 on the motherboard.

4. Remove the SATA power cables from the hard disk drives.

5. Detach the SATA power cable from the power connector of the dual cable for the DVD drive.

6. Detach the 8-pin power cable from the connector from the Fiery QuickTouch.

7. Remove any tie-wraps securing the power cables to the chassis.

8. Place the PS-50 in the upright position.

9. Remove the motherboard from the chassis (see page 51).

10. Remove the four connector panel screws that secure the power supply to the back of the chassis (see Figure 31).

11. While squeezing the power supply unit, remove the inside screw with washer.
12 Slide the power supply towards the front panel and take the power supply off from under the chassis bar.

**Figure 31:** Removing/replacing the power supply

1. Make sure that the PS-50 is in upright position.
2. Position the power supply inside the chassis (see Figure 31 on page 68).
   - Insert the power supply unit under the chassis bar, and place the power supply on top of the left and right chassis bars. Position the power supply so that it is flush against the connector panel.
3. Install the inside screw with washer to secure the power supply unit to the chassis top.

**Note:** To service the power supply, place the PS-50 in an upright position.

**To replace the power supply**

1. Make sure that the PS-50 is in upright position.
2. Position the power supply inside the chassis (see Figure 31 on page 68).
   - Insert the power supply unit under the chassis bar, and place the power supply on top of the left and right chassis bars. Position the power supply so that it is flush against the connector panel.
3. Install the inside screw with washer to secure the power supply unit to the chassis top.
4 Install the four screws that secure the power supply to the connector panel of the chassis.

5 Replace the motherboard (see page 53).

6 Connect one of the SATA power cables to the power connector on the dual data/power cable that connects to the DVD drive.

7 Connect three of the other SATA power cables to the SATA power connectors on the hard disk drive.

8 Connect the power cables to the motherboard (see Figure 19 on page 38 and Figure 25 on page 50):
   • 8-pin power cable to connector PWRCONN1
   • 24-pin power cable to connector J18

9 Replace the tie-wraps that you removed earlier.

10 Reassemble the PS-50 and verify its functionality (see page 75).

**Hard disk drive**

The factory-installed hard disk drive is formatted and loaded with system software, network drivers, and printer fonts. The hard disk drive is also used to store spooled print jobs. Available space on the hard disk drive is displayed in Command WorkStation.

If you replace the hard disk drive with a new one, you must restore the backup (see page 76) or install system software as described on page 88. (Spare hard disk drives are not shipped with preinstalled system software.)

⚠️ **Important:** Do not replace the hard disk drive and the motherboard at the same time. Doing so in the wrong order, without updating the system (see page 52), will cause the system to malfunction.

It is unlikely that both the hard disk drive and the motherboard are defective. Avoid replacing both to solve one problem. If troubleshooting strategies (such as checking cables and connections; see page 96) do not solve the problem, and you suspect either the hard disk drive or the motherboard is at fault, use the following order to troubleshoot: replace the hard disk drive, install system software, and then check to see if the problem persists. If it does, perform other procedures, such as replacing the motherboard (see page 52).

**Proper handling**

⚠️ **Important:** Improper handling can damage a hard disk drive. Handle the hard disk drive with extreme care.

- Use proper ESD practices when grounding yourself and the PS-50.
- Keep magnets and magnetic-sensitive objects away from the hard disk drive.
- Do not remove the screws on top of the hard disk drive. Loosening these screws voids the warranty.
- Never drop, jar, bump, or put excessive pressure on the hard disk drive.
- Handle the hard disk drive by its sides and avoid touching the printed circuit board.
- Allow the hard disk drive to reach room temperature before installation.
Hard disk drive problems may be caused by the following:

- Loose or faulty connections
- Faulty data or power cable
- Faulty hard disk drive

⚠️ **Important**: Make sure that you attach an ESD grounding wrist strap and follow standard ESD precautions before handling PS-50 components.

The hard disk drive is mounted inside a bracket (see Figure 33 on page 72).

If you are replacing the hard disk drive with a new one, you will need:

- The appropriate system software and documentation for the PS-50 that you are servicing.
- A compatible version of the user software for the networked computers that will print to the PS-50.

**To remove the hard disk drive**

1. If you are removing the hard disk drive in order to install a new drive, give the site administrator the opportunity to print the Job Log and save any custom simulations. If possible, create a system backup (page 76), and print the Configuration page and Font List.

2. Shut down and open the PS-50 (see page 39).

   To access the hard disk drive, you must remove the left panel.

3. Remove the power supply cable from the hard disk drive.

4. Remove the hard disk drive data cable from the hard disk drive.

5. Remove the screw securing the hard disk drive bracket to the bracket shelf.

6. Slide the hard disk drive bracket off the shelf and lift it out of the chassis.

   Unlock the hard disk drive bracket by moving the latch toward the connector panel, and then sliding the bracket off the bracket shelf.

⚠️ **Important**: Avoid striking the DIMMs as you remove the hard disk drive bracket.

**Note**: You will encounter slight resistance as you slide the bracket off the shelf. The resistance is caused by two tension points on the bottom of the bracket. The resistance helps control the bracket’s movement during removal and installation.
Figure 32: Removing/replacing the hard disk drive bracket

1. Tension points
2. Latch
3. Hard disk drive bracket
4. Shelf
5. Screw

Note: Printer interface board and internal cables are not shown.
7  Remove the four screws that attach the hard disk drive to the hard disk drive bracket (see below).

Figure 33: Removing/replacing the hard disk drive from/in the hard disk drive bracket

![Diagram of hard disk drive parts]

1  2.5 inch HDD
2  Mounting bracket for 2.5 inch HDD
3  Screw with washer (1/4)
4  HDD sled
5  Screw (1/4)

8  Remove the hard disk drive from the hard disk drive bracket and place it in an antistatic bag.

⚠️ Important: Do not loosen the screws on the hard disk drive cover. Loosening these hard disk drive screws breaks the seal and voids the hard disk drive warranty.

Do not touch the drive with magnetic objects (such as magnetic screwdrivers), and avoid placing magnetic-sensitive objects (such as credit cards and employee ID cards) near the hard disk drive.

Replacement hard disk drives are not shipped with preinstalled system software. After you install the drive, you must install the appropriate system software.

To replace the hard disk drive

⚠️ Important: Do not install a new hard disk drive and a new motherboard at the same time. If you suspect that the PS-50 needs a new hard disk drive and a new motherboard, first install the new hard disk drive and install system software, then install a new motherboard and transfer options (see pages 52 and 56).

1  If you are installing a new hard disk drive, unpack the drive.

Do not drop, jar, or bump the hard disk drive. Do not touch the hard disk drive with magnetic objects or place magnetic-sensitive objects near the hard disk drive.
Position the hard disk drive inside the hard disk drive bracket and align the front-most mounting holes on the hard disk drive with the four holes in the bracket.

When correctly installed, the hard disk drive extends about an inch past the rear of the bracket.

Replace the four screws that you removed earlier to attach the hard disk drive to the bracket.

Slide the bracket all the way onto the shelf and lock it by moving the latch toward the front panel.

Important: Avoid striking the DIMMs as you replace the hard disk drive bracket.

Note: You will encounter slight resistance as you slide the bracket onto the shelf. The resistance is caused by two tension points on the bottom of the bracket. The resistance helps control the bracket’s movement during removal and installation.

Secure the hard disk drive bracket to the hard disk drive shelf using the screws that you removed earlier.

Connect one end of the hard disk drive data cable to the hard disk drive and the other end to SATA1 on the motherboard (see Figure 25 on page 50).

Connect the power cable to the hard disk drive.

Reassemble the PS-50 (see page 75).

If you replaced the hard disk drive with a new hard disk drive, install system software (see page 88).

If a startup error displays on the Fiery QuickTouch when you power on the PS-50, check the connections.

Verify functionality (see page 75).

DVD drive

The DVD drive is installed in the front of the chassis. The drive is used to install system software and archive data on writable media.

To remove the DVD drive

1 Shut down the PS-50, remove all cables from the back, and then open the system (see page 39).

To access the DVD drive, you must remove the left, right, and front panels from the chassis.

2 Remove the data/power cables from the dual connector on the back of the DVD drive.

If you are removing the cable assembly to replace it with a new cable assembly, detach the other ends of the cables from the motherboard and the power supply.
3 Release the front latches on both side of the DVD drive by squeezing the levers, and pull the DVD drive out of the slot.

**Figure 34:** Removing/replacing the DVD drive

4 If you are replacing the DVD drive with new one, remove the eight screws on the side of the DVD drive and remove the ears.

Set aside the screws so that you can replace them later.

**To replace the DVD drive**

1 If you are installing the new DVD drive, attach the ears on both side of the DVD drive using the eight screws you removed earlier.

2 Insert the DVD drive into the front panel cutout until the latch snaps.

3 Connect the data/power cables to the connectors on the back of the DVD drive.

Make sure that the other ends of the cable are connected to the power supply and to Mini SAS on the motherboard.

4 Reassemble the PS-50 and verify its functionality (see page 75).
Restoring and verifying functionality after service

Before you leave the customer site, make sure that you complete the following steps. If you cannot complete a step, determine the reason and correct the problem before continuing. For more information, see Troubleshooting on page 96.

To reassemble the PS-50 and verify functionality

1 Reseat all boards, cables, connectors, and other parts loosened or removed during service.

When routing cables inside the PS-50, make sure that:

• Covers are securely installed after routing cables
• Cable routing does not interfere with the operation of internal components nor interfere with removing or replacing components
• Cables are not tangled nor looped around internal circuit boards or components (such as capacitors and resistors)
• Cables do not lie on or against any internal heating element
• Cables do not interfere with opening or closing PS-50 panels
• Cable slack is secured with a tie-wrap

2 Restore the PS-50 to the upright position.

3 Replace any panels that you removed earlier, as described on page 39.

4 If you replaced the motherboard, make sure that the new motherboard solves the problem that you are troubleshooting, and then transfer options to the new motherboard (see page 56).

5 If the PS-50 is to be mounted on the furniture with the monitor, see the reassembly instructions that is provided with the furniture assembly (page 114).

6 Connect the power cable to the PS-50 (see page 16).

7 Connect the PS-50 to the printer (see page 20).

8 Print the Test Page and Configuration page.

• If pages do not print, verify that the interface cables are properly connected.
• If image quality is poor, test the printer (see the service documentation that accompanies the printer).

9 Connect to the network (see page 20).

10 Ask the site administrator to download a test job over the network.

If the job does not print, or has poor image quality, see printing problems and the Troubleshooting sections of the user documentation.
Performing Backup and Restore

This chapter provides information about how to back up or restore information to the system. The PS-50 ships with system software pre-installed on the hard disk drives (HDDs). A factory-installed backup partition is available for restore if there is no on-site usable backup.

You can use three features to create backups and restore the backup images:

- **Fiery System Installer**
  
  You need to have the System Software DVD 1 to start the Fiery System Installer. This backup captures all settings, files, and jobs on the PS-50. You can restore this backup after you replace the HDD.

- **Fiery System Restore**
  
  You can access Fiery System Restore from the WebTools or Fiery QuickTouch. This backup captures all settings and files on the PS-50. You can create a backup and restore the backup when the PS-50 is not working. You can also schedule the automatic backup. This method does not require you to use the System Software DVD 1.
  
  See Table 3 for more detailed information on the Fiery System Installer and Fiery System Restore.

- **Command WorkStation and Configure WebTools**
  
  This backup captures the customer settings and data. You can restore the custom settings after you reinstall the system software or upgrade to the newer version.

**Note:** The system image does not include VDP/FreeForm resources. To back up the FreeForm masters 1 and 2, save the configuration settings as described in "Backing up the system configuration" on page 78.

**Table 3:** Details of the backup and restore using Fiery System Installer and Fiery System Restore

<table>
<thead>
<tr>
<th>Backup method</th>
<th>Description of backup image</th>
<th>Bootable option</th>
<th>Possible destination</th>
<th>Restore method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiery System Restore in WebTools or Fiery QuickTouch: Fiery System Restore &gt; Manual Backup &gt; Media selection &gt; Fiery factory image</td>
<td>Factory default image, manually backed up. Includes factory default version of software and configuration settings. Does not include print job information (print jobs, job logs, and job settings such as paper size).</td>
<td>Factory default image can only be saved as a bootable image, and requires a bootable USB device.</td>
<td>USB device only.</td>
<td>• Can restore directly from image • Fiery System Restore • Fiery System Installer</td>
</tr>
</tbody>
</table>
Backup recommendations

Even though the server maintains a backup you can use for recovery of the factory installation, creating a separate backup provides the ability to retrieve customized settings and job information if a recent backup is needed. You can create a backup by using Fiery System Restore (from Command WorkStation, WebTools, or Fiery QuickTouch), or Fiery System Installer.

- To create a backup using Command WorkStation, or from a remote location using WebTools, see “Backing up the system configuration” on page 78.
• To create a backup using Fiery System Restore, see “Using Fiery System Restore” on page 81.
• To create a backup using Fiery System Installer, see “Using Fiery System Installer” on page 83.

When backing up an existing PS-50 installation

• For an existing PS-50 installation, first check if a backup image exists either on the server or an external location.
  • If a backup image exists, check if it is up to date. Compare the date stamp of the existing backup image to the date of the last patch installation.
  • If a backup image does not exist, create a new one after installing all available software updates.
• The backup image may be saved to or found in any of the following locations:
  • Local Disk
  • USB drive
  • External hard disk drive
  • Network
• If you do not have a backup with the system settings and jobs, the system can access a preinstalled recovery backup on the hard disk drive provided with the PS-50. See “Backing up the system configuration”.

⚠️ Important: If you restore the system using the pre-installed recovery backup, the system and configuration will be reset to the factory default.

• If you have a system backup that includes your settings and jobs, you can recover them from your backup media you have created with Fiery System Installer.

⚠️ Important: Backed up data can be only restored to the same PS-50.

• Use a descriptive and consistent naming convention when saving image files (such as date, product name, product version, and short description).

After creating a backup image file, it is recommended that you transfer the image file to an external location, such as a network location or external drive.

⚠️ Important: If you select USB drive or external hard disk drive as a destination, all the existing data in the drive will be lost when you create a backup on these media.

Backing up the system configuration

If you back up the system configuration, you can restore that configuration after reinstalling or upgrading system software.

When you back up the system configuration, you save a configuration file that includes one or more of the following:

• Fiery System Settings
• Color Settings
• Preflight Presets
• Command WorkStation settings (if you are using a keyboard, monitor, and mouse)
• FreeForm/VDP resources
• Virtual Printers
• Server Presets
• Fonts
• Job Log

**Note:** Those settings you do not choose are not saved for restore.

If you cannot create a configuration file, ask the site administrator to archive custom color profiles, preflight presets, FreeForm masters, customer-installed fonts, and the Job Log to removable media or a network location.

**To save the system configuration using Command WorkStation**

1. Ask the site administrator to print the Job Log, Server Configuration page, and Font List (if possible).
2. Launch Command WorkStation and connect to the PS-50 with Administrator privilege.
   
   The default password for Administrator is Fiery.1 (case-sensitive), but the site administrator may have changed the password.
3. From the Server menu, select Device Center. In Device Center window, select Tools > Backup & Restore.
4. In the Backup & Restore dialog box, click Backup > Next, and then select the items you want to back up, click Next.
5. Enter a file name and location, specify if you want to add the date to the file name, and then click Next.
6. Click Finish.

**To save the system configuration using WebTools**

1. Ask the site administrator to print the Job Log, Server Configuration page, and Font List (if possible).
2. Start a web browser and access the PS-50 by entering the server name or IP address of the PS-50.

   **Note:** If a message about an untrusted connection appears or you are asked whether you want to proceed, you can safely ignore the message and proceed by clicking Continue to website.
3. In WebTools, click the Configure tab on the left side.
4. Log on with Administrator privileges and click OK.
   
   The default password for Administrator is Fiery.1 (case-sensitive), but the site administrator may have changed the password.
5. On the left side, choose Fiery Server > Backup.
6 In the Backup dialog box, select the settings you want to back up.

7 Enter a file name and location, specify if you want to add the date to the file name, and then click Backup.

8 Click OK.

Restoring the system configuration

You can restore the system configuration of the PS-50 to its previous state using a previously-saved system configuration file. For more information about the system configuration file, see page 79.

If you could not save a system configuration file, you must configure Setup. After you exit Setup and the PS-50 reboots, ask the site administrator to restore any archived settings and files. For more information, see Configuration and Setup, which is part of the user documentation set.

To restore the system configuration from Command WorkStation

1 Launch Command WorkStation and connect to the PS-50 with Administrator privilege.
   The default password for Administrator is Fiery.1 (case-sensitive), but the site administrator may have changed the password.

2 From the Server menu, select Device Center. In Device Center window, select Tools > Backup & Restore.

3 In the Backup & Restore dialog box, click Restore > Next.

4 Select the items to restore, and click Next.
   You can specify the backup file clicking the Browse, or you can select a recent backup.

5 Select settings to restore and click Next.

6 Click Finish.

To restore the system configuration using WebTools

1 Start a web browser and access the PS-50 by entering the server name or IP address of the PS-50.

Note: If a message about an untrusted connection appears or you are asked whether you want to proceed, you can safely ignore the message and proceed by clicking Continue to website.

2 In WebTools, click the Configure tab on the left side.

3 Log on with Administrator privileges and click OK.
   The default password for Administrator is Fiery.1 (case-sensitive), but the site administrator may have changed the password.

4 On the left side, choose Fiery Server > Restore.

5 Select the reference file and data file, click Next.
   For more information, see page 79.
6. Select settings to restore and click Next.

7. Click Reboot.

Using Fiery System Restore

Fiery System Restore allows you to create a backup of the PS-50 for quick recovery later when any problem happens. You can restore the PS-50 either from images stored on the local hard disk, or from a bootable USB drive. Fiery System Restore also provides the feature of creating the scheduled backups.

You must log in to the PS-50 as a system administrator to use the Fiery System Restore features.

You can access the Fiery System Restore from the WebTools tab, Fiery QuickTouch, or Command WorkStation.

To access Fiery System Restore from Fiery QuickTouch

1. On Fiery QuickTouch, press the Quick launch icon on the bottom-left corner of the screen.

2. Press the Fiery System Restore icon and log in as a system administrator.

3. Follow the on-screen menus to schedule automatic backups, manually back up the PS-50, or restore the PS-50.

To access the Fiery System Restore from Command WorkStation

1. Start Command WorkStation and login to the PS-50 with Administrator privileges.

   The default password for Administrator is Fiery.1 (case-sensitive), but the site administrator may have changed the password.

2. From the Server menu, select Device Center. In Device Center window, select Tools > Fiery System Restore.

   The Fiery System Restore will display on the default web browser window.

To access the Fiery System Restore features from WebTools

1. From a client computer, start a web browser and enter the IP address or the DNS name of the PS-50.

   Note: If a message about an untrusted connection appears or you are asked whether you want to proceed, you can safely ignore the message and proceed by clicking Continue to website.

2. In WebTools, click the Fiery System Restore tab on the left side.

   The available features are listed under Fiery System Restore.

   You must log in to the system as a administrator before performing any of the backup/restore process.

   Note: The following tasks describe using Fiery System Restore on WebTools. Fiery QuickTouch uses the same menu selections and features for backing up and restoring the PS-50.

To setup automatic scheduled backup

Note: When you set up the scheduled backup, only the latest backup will be stored. Previous backups will be deleted.
Performing Backup and Restore

1. **In Fiery System Restore window, click Schedule Backup.**

   If you have not logged in as an Administrator user, you are required to do so. Enter the administrator’s password (default password is **Fiery.1**), and click Log In.

2. **Select Enable automatic backup**, and select when you want to start the backup process on the PS-50.

   **Note:** The backup process takes more than an hour to complete and it requires the PS-50 to be Idle status. If the PS-50 is not in Idle status, the backup process does not start.

3. **Click Save.**

   **To create a manual backup**

   1. **In Fiery System Restore window, click Backup Now.**

      If you have not logged in as an Administrator user, you are required to do so. Enter the administrator’s password (default password is Fiery.1), and click Log In.

   2. **In Backup dialog box, select the media in which you want your backup file saved, and click Continue.**

      - **USB:** Select this option when you create a backup on a USB flash drive. If you want to create a backup of the current PS-50 on the USB flash drive, select New image. You can select Create bootable image to make the USB flash drive a bootable media.

         If you want to create a factory image backup on a USB flash drive, select Fiery factory image. The Create bootable image option will be automatically turned ON.

         **Note:** The minimum size for the USB flash drive depends on the actual size of the backup file. You can determine the size of the backup file by checking the Estimated size: field in the Create USB Backup dialog box. Prepare the USB flash drive with enough capacity.

         **Note:** Due to a file system restriction, the maximum size of the USB flash drive is 32GB if the Create bootable image option in ON. You can use a USB flash drive with more than 32GB capacity if the Create bootable image is OFF.

      - **Internal hard drive:** Select this option when you create a backup on the HDD of the PS-50. You must specify the file name of the backup image. The default image name is the server name of the PS-50.

   3. **Make sure to connect the USB drive to the USB connector on the PS-50.**

      **Note:** If the capacity of the USB flash drive is less than size of the value listed in Estimated size: field, the backup process will not take place.

   4. **Click Continue.**

   **To restore the backup image**

   1. **In Fiery System Restore window, click Restore.**

      If you have not logged in as an Administrator user, you are required to do so. Enter the administrator’s password (default password is Fiery.1), and click Log In.
2 Make sure that your backup image is accessible from the PS-50.

If you want restore the backup image stored on the USB flash drive, be sure to attach the USB flash drive to one of the USB 3.0 ports on the PS-50.

3 Select one of the following restore options:
   - Restore from a local image
   - Restore from a USB storage device
   - Restore from the factory default image

4 Click Continue.

5 Follow the on-screen prompts to restore the backup image.

Note: The PS-50 must remain powered ON during the backup or restore process.

To restore the system by booting from a bootable USB flash drive
   - Follow the instructions described in “To restore the system from bootable backup media” on page 86. You need to connect a monitor, keyboard, and mouse to the PS-50.

Using Fiery System Installer
You can create the system backup or restore from the backup using Fiery System Installer provided with the System Software DVD 1.

⚠️ Important: It is recommended that you create system backups periodically.

You can perform the following tasks from Fiery System Installer;

- **New Installation**: Installs the system software from the media shipped with the PS-50. Use this option only when the system backup is not available. See also “Installing system software” on page 89.

- **Restore using a backup image or the recovery partition**: You can restore the system by selecting the backups that you created before. If there is no backup available in the system or in any attached devices, you can only perform the restore from the recovery partition.

- **Back up hard disk drive(s)**: Use this option when you create the system backups. You can specify the location of the backup, file name, and other attributes of the backups.

- **Platform Utilities**: You can perform the backup management tasks from this option such as erasing hard disks or using Windows Task Manager to explore the system.

  Note: The Platform Utilities is available only on the monitor.

Note: You can use the PS-50 Fiery QuickTouch to operate Fiery System Installer. You can also use a monitor, mouse, and keyboard attached if available.
Backup with Fiery System Installer

You must back up your system and create a backup image to recover from any unexpected system crashes and the hard disk drive failure.

To create a system backup

1. Start Fiery System Installer.
   - Insert the System Software DVD 1 into the DVD drive of the PS-50.
   - Reboot the PS-50 (see page 31).
   - When the server finishes the reboot, select the language you use for the backup or restore session.

2. From “What do you want to do?” screen, select “Back up hard disk drive(s).”

3. Enter the backup settings.
   Because settings vary depending on the destination you select, make sure that you specify valid settings.

   The Backup settings window appears. In this window, do the following:
   - Select a backup destination from one of the following locations: Local Disk, USB drive, External hard disk drive, or Network.
   - Specify the name of the backup file in the Folder Name field.
     Fiery System Installer creates a folder with the name containing the file name and a time stamp to help you distinguish the backup images. The default file name is the server name. The installer automatically generates the time stamp.
   - If you select, “Include Fiery job files in backup” jobs archived in the server are included in the backup.
   - If you select, “Create bootable media,” the USB device or hard disk drive specified as a destination becomes a bootable media. Select this option when you want to boot the PS-50 from the backup media to avoid the situation where the HDD fails and cannot boot the PS-50. See page 85 for booting from the bootable media. Bootable media is used for system restoration when a hardware failure occurs.
     ! Important: All the existing data in the USB drive or external hard disk drive will be lost when you create a backup on these media.
   - Enter a description of the backup.
   - If you select Save in the backup settings, the system saves the specified backup setting for a subsequent Load. Only the specified setting is saved.

4. If you select USB Drive or External Hard Disk as a destination in step 3, make sure you attach the appropriate device to the PS-50.

5. Click Start backup to begin the backup process.
If there is a need to stop the backup process, press the cancel icon. Fiery System Installer displays a message allowing you to restart or shutdown the server. You can specify a backup log to be saved, if desired.

**Restore with Fiery System Installer**

To recover from a system crash, you must restore the system with a backup image.

**Note:** Backed-up data can be only restored to the same PS-50.

**To restore the system using Fiery system installer**

You will access your backup media (USB drive, local hard disk drive or external hard disk drive) to restore the system.

1. Start Fiery System Installer.
   - Insert System Software DVD 1.
   - Reboot the PS-50 (see page 31).
   - When the menu appears, specify a language.

2. If your backup file is stored in the USB drive or external hard disk, attach the device to the PS-50.

3. From “What do you want to do?” screen, select Restore from backup or recovery partition.
   
   The Select backup source dialog appears. You can choose one of the following:

   - **Backup**
     
     If present, previous backups are listed for you to choose.

   - **Restore from recovery partition**
     
     This restores the server from a hard disk drive partition to its factory-built settings.

     ! **Important:** Any custom settings you have specified after installation are over-written.

   - **Search for backups from this system**
     
     This lets you select a backup from a displayed list. Alternatively, you can select Refresh, Import backup history, or Search the network for backups.

     If a backup image exists, the installer lists information about each backup image:

     - The time and date in which you created the backup.
     - The location of the backup image: Local Disk, USB drive, External hard disk drive, or Network.
     - Alternatively, you can also choose to Refresh, Import backup history, or Search network.

4. Select the source of the backup and click OK.

When a message appears indicating that all the data will be erased, click Continue to proceed the restore.
Using bootable backup media to restore

Use the following procedure when you restore the system without using the System Software DVD 1, or when the PS-50 does not boot from the built-in hard disk drive.

You can restore from the bootable backup media (including the Fiery factory image) created by either Fiery System Installer or Fiery System Restore.

To restore the system from bootable backup media

To restore from the bootable media, you must have created a backup with the “Create bootable media” option. If you have created a backup as bootable backup media, follow these instructions. You can use this procedure to install the system software after you replaced the new hard disk drive.

1. Shut down the PS-50.
2. Attach the bootable USB backup media to the PS-50.
   - Make sure to remove any media in the DVD drive. Do not attach other USB devices to the PS-50.
3. Press the power button to turn on the PS-50.
   - The PS-50 will boot from the bootable USB backup media.
4. Follow the instructions on the Fiery QuickTouch display or the monitor (if available) to restore the backup image.

Platform Utilities

Use Fiery System Installer for advanced procedures, such as erasing hard disks, or launching Windows Task Manager. These utilities are available when you select Platform Utilities.

Note: The Platform Utilities is available only on the monitor.

Erase data from hard disk drive(s)

If selected, the following methods are provided:

- Randomized erase for writing random data to all disk sectors before writing zero.
- Quick erase for writing zeroes to all disk sectors.

Advanced backup management

Allows the Administrator to:

- Load backup settings from a USB drive to apply to system backup images.
- Save or restore backup history files.
- Search for backup images created on a replaced system to be applied to the current one.
Launch Windows Task Manager

Starts the Windows Task Manager. Windows Task Manager displays the programs, processes, and services that are currently running on the PS-50. You can use Windows Task Manager to monitor performance or to close a program that is not responding.
Installing System Software

This chapter provides information about how to install system software.

The PS-50 is shipped with system software pre-installed on the hard disk drives (HDDs).

A reinstallation of the system software DVDs will be required if:

- You have replaced the hard disk drive.
- Restoring the system from backup images did not solve the problem you are troubleshooting.

When you reinstall from the System Software DVDs

The following issues apply to the scenario where you reinstall the system from the System Software DVDs.

- **Jobs:** When you reinstall system software, all jobs in all print queues and all jobs archived locally on the PS-50 hard disk are deleted. To save jobs, ask the site administrator to save them to removable media or a network location, so they can be re-imported to the PS-50 after system software installation. For more information, see Command WorkStation Help.

- **Job Log:** When you reinstall system software, the list of jobs in the Job Log and any jobs in the queues are deleted. The site administrator can use Command WorkStation to save a current list of jobs (not the actual jobs) from the Job Log.

- **Fonts:** When you reinstall system software, all fonts on the hard disk drives are deleted. Resident fonts are reinstalled when you reinstall system software. Any customer-supplied fonts must be reinstalled by the site administrator (see Command WorkStation Help).

  To determine which additional fonts were downloaded to the PS-50, print the Font List before you reinstall the system software and again after you complete the system software installation. Any fonts *not listed* after installation will need to be reinstalled. For more information about managing fonts, see Command WorkStation Help.

- **User software:** The PS-50 ships with preinstalled user software on the hard disk drives. During system software reinstallation, you are prompted to reinstall user software (including Command WorkStation) using the User Software DVD.

- **Server Configuration page:** Before you reinstall a new version of system software, print the Server Configuration page. The Server Configuration page provides a record of the customer's current Setup configurations.

- **Backing up and restoring the configuration:** All Setup configurations, as well as all custom files and templates stored on the hard disk drives, are deleted when you reinstall system software. Always back up the current PS-50 configuration before you reinstall system software. After the installation is completed, be sure to restore the configuration that you saved earlier. For instructions, please see “Performing Backup and Restore” on page 76.

- **Compatibility:** After you upgrade system software, remind the site administrator to upgrade user software on all computers connected to the PS-50. Using old user software with new system software may negatively affect the system.
Installing system software

Install both system software DVDs when you replace a hard disk drive or upgrade to the latest version of the PS-50 software. You can install software from the following disks:

- System Software DVD 1—Fiery System Software for the PS-50.
- System Software DVD 2 and 3—Windows operating system.
- User Software DVD 4—Fiery User Software for installation on the PS-50 and client computers.

To install and verify the system software installation

Follow these instructions to complete the system software installation:

- “Before you install or upgrade system and user software” on page 89.
- “Installing or upgrading the system and user software with Fiery System Installer” on page 89.
- “After installing or updating the system software” on page 91.
- “Verify the PS-50 operation” on page 93.
- “Before you leave the customer site” on page 94.

Before you install or upgrade system and user software

1 Before you proceed, do the following:

- Ask the site administrator to
  - Print the Job Log, Server Configuration page, and Font List, if possible.
  - If any options are activated on the server, you must deactivate them prior to reinstalling.
  - Archive and export to an external hard drive, USB storage device or network folder any customer-installed fonts and FreeForm masters, if possible.
  - Save and export to an external hard drive USB storage device or network folder any custom simulation profiles and custom spot color settings, if possible.

  **Important:** Remove all dongles and devices, on the PS-50 except the keyboard and mouse. If you do not remove dongles or devices, the system software installation may fail.

2 If you are installing system software, back up the system configuration (if possible).

For more information, see page 78.

Installing or upgrading the system and user software with Fiery System Installer

You can use the PS-50 or Fiery QuickTouch to use Fiery System Installer. You can also use a monitor, mouse, and keyboard attached if available.
The System Software installation takes approximately 1.5 hours to complete.

**Note:** During the installation, you need to access the DVD drive often. Keep the front door open when you install the system software.

**Note:** If Fiery Impose or Fiery Compose is activated, you must deactivate them before you reinstall.

1. Disconnect the network cable, crossover Ethernet cable, and printer interface cables from the back of the PS-50 (see Figure 2 on page 18).
   
   If you do not, installation will fail.

2. Insert System Software DVD 1 into the DVD drive.

3. Reboot the PS-50.

   Wait while the system boots from the DVD.

4. When the language selection screen displays, select a language.

   The language selection screen displays on the monitor and on Fiery QuickTouch. If you select a language on either device, you will need to complete the entire installation on that device, and the other device's screen will be locked for the duration of the installation.

5. When “What do you want to do?” screen displays four choices, select **New Installation**.

6. When “This installation will erase all data on the hard disk drive(s). Continue?” message displays, select **Continue**.

7. After copying the System Software DVD 1 contents to the hard drive, eject DVD 1 and insert System Software DVD 2.

8. After copying the System Software DVD 2 contents to the hard drive, eject DVD 2 and insert System Software DVD 3.


   When you eject User Software DVD 4, the PS-50 reboots to begin the software installation.

10. Wait while the PS-50 complete the installation. This will take about 45 minutes.

    The following steps are for use with a keyboard, monitor, and mouse. If you are not using a keyboard, monitor, and mouse, skip to step 16.

11. When the PS-50 becomes Idle, click the mouse to show the login screen on the monitor. Enter the Administrator's password and then press Enter.

    **Fiery.1** is the default password and is case-sensitive.

12. Ask the site administrator to follow the on-screen instructions in the Fiery Setup Wizard to configure the PS-50 for the customer's print environment.

   Once the configuration in the Fiery Setup Wizard is done, you must restart the server for the changes to take effect. If desired, you can print a Server Configuration page after the restart to confirm the default settings.
13 Wait for the Command WorkStation to start.

During the installation, a localhost connection to Command Workstation is created, so when you start the PS-50, Command WorkStation starts also.

14 (Optional) Install and activate Fiery Impose.

For more information, see the installation document that accompanies the Fiery Impose kit (Installing the Fiery Option).

15 (Optional) Install and activate Fiery Compose.

16 Shut down the PS-50 (see page 31).

After installing or updating the system software

1 Restore the dongles and devices that you removed in a previous step, if applicable.

2 Start the PS-50 (see page 31).

3 Install any required software patches by System Updates (see page 94).

4 (Optional) Reinstall and reactivate Color Profiler Suite software on the PS-50:

Use the Color Profiler Suite CD to reinstall the software on the PS-50. For complete instructions, see the documentation that accompanies the Color Profiler Suite kit.

5 (Optional) Reinstall and reactivate Fiery Impose and/or Compose on the PS-50.

6 (Optional) Set up the proxy configuration if you have a proxy server.

In Configure, click Fiery Server > System Updates > Enable System Updates > HTTP Proxy Settings, and enter the proxy server information. Save your changes and reboot the PS-50.

You can also enter the proxy server information in System Updates application if a monitor, mouse, and keyboard are attached to the PS-50.

For more information on setting up proxy configuration, see Configuration and Setup, which is part of the user documentation.

Installing the Fiery QuickTouch software

The Fiery QuickTouch software will update automatically if the PS-50 has access to Internet, or if the PS-50 system update is activated. Install or update the Fiery QuickTouch software when you encounter the following:

- The Fiery QuickTouch is not responding.
- You replaced the Fiery QuickTouch with a new one.

Before you reinstall the Fiery QuickTouch software

If the Fiery QuickTouch does not power up after starting the PS-50, or if it is not responding, do the following before you reinstall the Fiery QuickTouch software:
- Restart the PS-50 (see page 31).

- Reboot the PS-50 (see page 31).

- Shut down the PS-50, wait one minute, and then power on the PS-50 by pressing the power button on the front panel (see page 31).

- Reset the Fiery QuickTouch: press the reset button on the Fiery QuickTouch through the pinhole, and hold the button down for two seconds (see Figure 16).

After performing these methods, if the Fiery QuickTouch does not start up or not responding, proceed to install or update the Fiery QuickTouch software (see page 92).

**To install or update the Fiery QuickTouch software**

1. Make sure that the PS-50 is Idle.

2. From the monitor connected to the PS-50, or from the Remote Desktop Connection session, locate the folder that includes the system update image file by following the steps below:

   a. Browse “C:\Glance\image\NX-<version_number>-system_update” folder. The image file is located in this folder if the Fiery QuickTouch software installation was incomplete, or if the image file is downloaded but not yet installed.

   b. If you do not find the above folder, go to the “C:\Glance\image_backup” folder. Copy “NX-<version_number>-system_update” folder and paste it in “C:\Glance\image”.

3. The PS-50 detects the update file and starts the update process. Wait until the Fiery QuickTouch update process completes and the PS-50 reaches Idle state.

   While updating the Fiery QuickTouch, the Fiery Ticker displays “Exited” on the status bar. Once the update is done successfully, Fiery Ticker displays Idle on the status bar. The update process may take approximately 10 to 15 minutes to complete.

   If the update process is not complete and the Fiery Ticker continues to display “Exited” on the status bar, proceed with the step 4 to complete the update process manually.
4 Rotate the Fiery QuickTouch 45 degrees so that the pin hole (download button) at the bottom of the Fiery QuickTouch is accessible.

**Figure 35:** Reset and download buttons on the Fiery QuickTouch

![Reset and download buttons](image)

1 Reset button
2 Download button (accessible when Fiery QuickTouch is rotated about 45 degrees)

5 Using two paper clips, press the download button.

While pressing the download button, press the reset button on the right side next to the USB ports.

The Fiery QuickTouch system enters the download mode.

6 Access the “C:\Glance\image\NX-<version_number>-system_update” folder, and double-click the “flash.bat” file.

7 Wait until the Fiery QuickTouch completes the installation and displays the Home screen. The installation may take approximately 10 to 15 minutes to complete.

**Verify the PS-50 operation**

1 Print the Test Page and the Server Configuration page.

If the Test Page does not print, verify that the printer interface cables are securely connected and on the correct ports, and verify that the printer interface board is securely connected to the motherboard.

If image quality is poor, test the printer (see the service documentation that accompanies the printer).

2 Verify that the PS-50 is connected to the network (see page 30).
3 Ask the site administrator to download a test job over the network.

If the job does not print or has poor image quality, see the Troubleshooting topics in *Configuration and Setup*, which is part of the user documentation.

**Before you leave the customer site**

1 Remind the site administrator to do the following:
   - Import archived jobs.
     
     Please note that some archived jobs may not print if you have upgraded the PS-50 to the newer version.
   - (Optional) Register Adobe Acrobat the first time you use it.

2 Reinstall the following:
   - Fonts
   - Custom simulations

   **Note:** This upgrade may not be compatible with old user software.

3 Back up the PS-50 hard disk drives.

**System software installation error messages**

If an error message displays when you install or upgrade system software, do the following:

- If prompted, save the log.
- If you are not prompted to save the log, record the error message.
- If the network cable and printer interface cables are still connected to the PS-50, disconnect the cables and perform the installation again, starting from “Installing or upgrading the system and user software with Fiery System Installer” on page 89.

If you cannot correct the error, contact your authorized service/support center. A log or error message may help to solve the problem. Provide as much specific information as possible.

**Installing software patches**

As part of reinstalling system software, you must reinstall software patches. For a list of patches that were installed on the PS-50, see the Server Configuration page that you printed before reinstalling. You may also need to reinstall software patches as part of upgrading system software.

After you know which software patches are required for your system, you can download them from System Updates or WebTools.

**To download software patches from System Updates**

1 From the Windows Start menu, click **All apps > Fiery > System Updates.**
2 Click Check Now.

**To download software patches from WebTools**

1 Start a web browser and access the PS-50 by entering the server name or IP address of the PS-50.

**Note:** If a message about an untrusted connection appears or you are asked whether you want to proceed, you can safely ignore the message and proceed by clicking Continue to website.

2 On the WebTools home page, click Check for Product Updates.
Troubleshooting

The PS-50 is a server for printers, and is generally part of a configuration that has connectivity to the printer and workstations or computers. Problems may occur in one of three areas:

- Inside the PS-50
- In the interface between the PS-50 and the printer
- In the interface between the PS-50 and the workstations or computers to which it is connected

This chapter identifies the source of common problems that may occur with the PS-50 and suggests ways of correcting them. This chapter does not attempt to provide troubleshooting information for attached computers such as Windows or Mac OS computers, printers, or extensive networks. Refer problems in these areas to the appropriate service departments and network administrators.

If network administrators need to troubleshoot job errors that occur with Command WorkStation, refer them to *Configuration and Setup* for more information, including how to use the Job Error Report feature to collect error information to send to EFI Technical Support.

⚠️ **Important:** When performing the service procedures described in this chapter, follow the precautions listed in page 9.

Preliminary on-site checkout

Most problems with the PS-50 are caused by loose board or cable connections. This section describes the quick checks that you can do to locate and fix obvious problems. It describes how to eliminate any problems with external connections to the back of the PS-50, and then addresses checking internal board and cable connections.

Check external and internal connections before replacing any components.

**Note:** Verify that the network is functioning, no unauthorized software or hardware is installed on the PS-50, and no problems have occurred with a particular print job or application. The on-site administrator can help you verify these issues.

For problems that persist after you check the external and internal connections, this section provides a comprehensive list of internal and external checks that may help you fix the problem.

Checking external connections

Before removing the side and front panels of the PS-50 to check internal components, eliminate the most obvious sources of problems. Make sure that:

- All interface cables to the system are plugged into the proper connectors (see page 39).
- The power cable is plugged into the wall power outlet.
- The LED on the network port is blinking to indicate network activity.
Checking internal components

To check the internal components, you must remove the side and front panels of the PS-50.

⚠️ **Important:** Before you remove the PS-50 panels, be aware of the safety precautions that you should take when handling the PS-50. Use standard ESD precautions when handling printed circuit boards and electronic components. To review the safety precautions, see page 9.

**To check internal components**

1. Shut down, and then open the PS-50 (see page 39).

   ⚠️ **Important:** Before you touch any components inside the PS-50, attach a grounding strap to your wrist and discharge any static electricity on your body by touching a metal part of the PS-50.

2. Inspect inside the PS-50

   - Make sure that no foreign materials have been dropped into the chassis.
   - Make sure that the DVD and hard disk drive data cables are connected to the correct SATA connectors on the motherboard.
   - Look for obviously loose boards and reseat each board securely in its connector on the motherboard.
   - Look for obviously loose cables and reseat each cable connector firmly.
   - Make sure that each connector is properly aligned with its mating connector. If the pins are offset from each other, the affected board will not function properly.

3. Reassemble the PS-50 and verify its functionality (see page 75).

Inspecting the system

⚠️ **Important:** If your initial checks of the cable and board connections do not fix the problem, you may need to inspect the system on a component-by-component basis, as described in “Inspecting the system” on page 97. A comprehensive inspection allows you to verify that each hardware component is properly installed and configured, and helps you avoid replacing expensive components unnecessarily.

If the system you are servicing does not meet a condition, and it is not obvious what action(s) you should take to fix the problem (for example, if the system hangs before reaching Idle), identify the symptom and perform the suggested action(s) for the condition.
<table>
<thead>
<tr>
<th>Conditions to verify</th>
<th>Part and additional page references</th>
</tr>
</thead>
<tbody>
<tr>
<td>When the problem occurs, verify the following:</td>
<td>External connectors, chassis fan, and power button, “Checking external connections” on page 96 and “Checking internal components” on page 97.</td>
</tr>
<tr>
<td>• Power cable is connected properly to the PS-50 and to the power outlet.</td>
<td></td>
</tr>
<tr>
<td>• The PS-50 is powered on.</td>
<td></td>
</tr>
<tr>
<td>• Chassis fans are operating.</td>
<td></td>
</tr>
<tr>
<td>• At least one LED on the network connector is lit.</td>
<td></td>
</tr>
<tr>
<td>• All external cables required are present, in correct connectors, well-seated.</td>
<td></td>
</tr>
<tr>
<td>• Cables, cable connectors, and mating connectors appear undamaged.</td>
<td></td>
</tr>
<tr>
<td>When the problem occurs, collect logs by doing the following:</td>
<td>Fiery QuickTouch, page 25.</td>
</tr>
<tr>
<td>1 Log into the PS-50.</td>
<td></td>
</tr>
<tr>
<td>You can log into the PS-50 with a monitor, keyboard, and mouse, or from a client computer with Remote Desktop.</td>
<td></td>
</tr>
<tr>
<td>2 On a web browser, type the following URL:</td>
<td></td>
</tr>
<tr>
<td><a href="http://10.10.100.2:8080/getlog">http://10.10.100.2:8080/getlog</a></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> You may need to either add the URL to your trusted sites list, or set the URL to bypass proxy depending on your network security settings.</td>
<td></td>
</tr>
<tr>
<td>3 Save the log file to your local system.</td>
<td></td>
</tr>
<tr>
<td>Click File &gt; Save As..., and save the log file as a .txt file.</td>
<td></td>
</tr>
<tr>
<td>4 Copy the following log files from the following location on the PS-50:</td>
<td></td>
</tr>
<tr>
<td>• C:\Glance\GlanceUpdatesMonitor\daemon\glanceupdatesmonitorservice.out.log</td>
<td></td>
</tr>
<tr>
<td>• C:\Glance\GlanceUpdatesMonitor\daemon\glanceupdatesmonitorser vice.wrapper.log</td>
<td></td>
</tr>
<tr>
<td>You can send these log files to EFI technical support.</td>
<td></td>
</tr>
<tr>
<td>If the problem occurs at power up or reboot, verify that:</td>
<td></td>
</tr>
<tr>
<td>• The Fiery QuickTouch is turned on and functional.</td>
<td></td>
</tr>
<tr>
<td>• The system does not hang, and no error messages occur before the systems reaches Idle.</td>
<td></td>
</tr>
<tr>
<td>• After the system reaches Idle, the Fiery QuickTouch LCD touch screen has functionality.</td>
<td></td>
</tr>
<tr>
<td>If the Fiery QuickTouch is not responding or does not power up after a reboot, do one of the following:</td>
<td></td>
</tr>
<tr>
<td>• Check the Fiery QuickTouch cable connections (see page 38).</td>
<td></td>
</tr>
<tr>
<td>• Restart the PS-50 (see page 31).</td>
<td></td>
</tr>
<tr>
<td>• Reboot the PS-50 (see page 31).</td>
<td></td>
</tr>
<tr>
<td>• Shut down the PS-50, wait one minute, and then power on the PS-50 by pressing the power button on the front panel (see page 31).</td>
<td></td>
</tr>
<tr>
<td>• Reset the Fiery QuickTouch: press the reset button on the Fiery QuickTouch through the pinhole, and hold the button down for two seconds (see Figure 16).</td>
<td></td>
</tr>
<tr>
<td>• Update or reinstall the Fiery QuickTouch software (see page 91).</td>
<td></td>
</tr>
</tbody>
</table>
### Conditions to verify

<table>
<thead>
<tr>
<th>Conditions to verify</th>
<th>Part and additional page references</th>
</tr>
</thead>
<tbody>
<tr>
<td>All replaceable parts are:</td>
<td>Chassis, page 35.</td>
</tr>
<tr>
<td>- Present</td>
<td></td>
</tr>
<tr>
<td>- Properly aligned</td>
<td></td>
</tr>
<tr>
<td>- Installed securely</td>
<td></td>
</tr>
<tr>
<td>- Installed on the appropriate site</td>
<td></td>
</tr>
<tr>
<td>- The correct part for the system</td>
<td></td>
</tr>
<tr>
<td>- Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>Chassis and contents have not been tampered with (no unauthorized additions or changes have been made).</td>
<td></td>
</tr>
<tr>
<td>Chassis does not contain any foreign objects.</td>
<td></td>
</tr>
<tr>
<td>Chassis and contents have not been tampered with (no unauthorized additions or changes have been made).</td>
<td>Motherboard (with the motherboard replacement dongle), page 47.</td>
</tr>
<tr>
<td>Motherboard, including components and traces, appears undamaged and no foreign objects are evident.</td>
<td>Important: When replacing the motherboard, carefully review the cautions on page 52.</td>
</tr>
<tr>
<td>Each CPU is present, installed in the correct connector, well-seated, and appears undamaged.</td>
<td>DIMMs for PS-50, page 58</td>
</tr>
<tr>
<td>Each CPU cooling unit is well-aligned and firmly attached.</td>
<td></td>
</tr>
<tr>
<td>Each fan (including fan cable) is well-positioned, installed in the correct connector, and appears undamaged.</td>
<td></td>
</tr>
<tr>
<td>Boards required on the motherboard are present, well-seated, and in the correct slots.</td>
<td></td>
</tr>
<tr>
<td>Battery is installed.</td>
<td></td>
</tr>
<tr>
<td>Each DIMM is well-seated and installed in the correct slot.</td>
<td></td>
</tr>
<tr>
<td>DIMM connectors are not oxidized (reseating removes oxidation).</td>
<td></td>
</tr>
<tr>
<td>Each board required is:</td>
<td>Printer interface board, page 46</td>
</tr>
<tr>
<td>- Present</td>
<td></td>
</tr>
<tr>
<td>- Installed in the correct slot</td>
<td></td>
</tr>
<tr>
<td>- Well-seated</td>
<td></td>
</tr>
<tr>
<td>- Appears undamaged</td>
<td></td>
</tr>
<tr>
<td>Required cables (if applicable) are:</td>
<td></td>
</tr>
<tr>
<td>- Present</td>
<td></td>
</tr>
<tr>
<td>- Firmly connected in the correct connectors</td>
<td></td>
</tr>
<tr>
<td>- Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>Each CPU is:</td>
<td>CPU with cooling assembly, page 59</td>
</tr>
<tr>
<td>- Present</td>
<td></td>
</tr>
<tr>
<td>- Installed in the correct socket</td>
<td></td>
</tr>
<tr>
<td>- The correct speed (CPU speeds must match)</td>
<td></td>
</tr>
<tr>
<td>- Well-seated</td>
<td></td>
</tr>
<tr>
<td>- Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>The CPU cooling unit is:</td>
<td></td>
</tr>
<tr>
<td>- Ready for efficient thermal transfer</td>
<td></td>
</tr>
<tr>
<td>- Well-aligned</td>
<td></td>
</tr>
</tbody>
</table>

**Important:** When replacing the motherboard, carefully review the cautions on page 52.
<table>
<thead>
<tr>
<th>Conditions to verify</th>
<th>Part and additional page references</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fan is:</td>
<td>Fan, page 65</td>
</tr>
<tr>
<td>• Properly positioned (not backwards)</td>
<td></td>
</tr>
<tr>
<td>• Installed in the correct connector</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged (fan, fan cable, cable connector, and motherboard connector)</td>
<td></td>
</tr>
<tr>
<td>The power supply required is:</td>
<td>Power supply, page 67</td>
</tr>
<tr>
<td>• Present</td>
<td></td>
</tr>
<tr>
<td>• Correctly installed</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>Cable connectors are:</td>
<td></td>
</tr>
<tr>
<td>• Firmly connected</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>• Installed in the correct devices</td>
<td></td>
</tr>
<tr>
<td>The hard disk drives are:</td>
<td>Hard disk drive, page 69</td>
</tr>
<tr>
<td>• Present</td>
<td></td>
</tr>
<tr>
<td>• Correctly installed</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>Hard disk drive data cables are:</td>
<td></td>
</tr>
<tr>
<td>• Present</td>
<td></td>
</tr>
<tr>
<td>• Firmly connected to the correct SATA connectors on the motherboard (see page 69)</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>Hard disk drive power cables are:</td>
<td></td>
</tr>
<tr>
<td>• Present</td>
<td></td>
</tr>
<tr>
<td>• Firmly connected to the SATA power connectors on the hard disk drives.</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>Conditions to verify</td>
<td>Part and additional page references</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The drive required is:</td>
<td>DVD drive, page 73</td>
</tr>
<tr>
<td>• Present</td>
<td></td>
</tr>
<tr>
<td>• Correctly installed</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>• Jumpered as the master (secondary) according to label</td>
<td></td>
</tr>
<tr>
<td>• Activity LED lights on power up</td>
<td></td>
</tr>
<tr>
<td>DVD drive SATA cable is:</td>
<td></td>
</tr>
<tr>
<td>• Firmly connected to motherboard SATA_6G_0</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged</td>
<td></td>
</tr>
<tr>
<td>Each cable required is:</td>
<td>Hard disk drive data cable, page 69</td>
</tr>
<tr>
<td>• Present</td>
<td>DVD drive power and data combination cable, page 73</td>
</tr>
<tr>
<td>• The correct type</td>
<td>Power supply, page 67</td>
</tr>
<tr>
<td>• Installed in the correct connector</td>
<td></td>
</tr>
<tr>
<td>• Well-seated</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged (including connectors)</td>
<td></td>
</tr>
<tr>
<td>If included in the system, the required mouse, monitor, and keyboard are present</td>
<td>• Mouse (if applicable)</td>
</tr>
<tr>
<td>and appear undamaged. The mouse and keyboard are connected to the correct ports on</td>
<td>• Monitor (if applicable)</td>
</tr>
<tr>
<td>the PS-50 connector panel.</td>
<td>• Keyboard (if applicable)</td>
</tr>
<tr>
<td>The cables required are:</td>
<td>• Monitor power cord (if applicable)</td>
</tr>
<tr>
<td>• Present</td>
<td></td>
</tr>
<tr>
<td>• Installed in the correct connector</td>
<td></td>
</tr>
<tr>
<td>• Well-seated</td>
<td></td>
</tr>
<tr>
<td>• Not visibly damaged (including connectors)</td>
<td></td>
</tr>
</tbody>
</table>
Error messages and conditions

To address specific error messages or conditions, see “PS-50 error messages and condition” on page 102. Use the table to locate the problem or symptom that you want to fix, read about the possible causes, and then perform the suggested actions to solve the problem.

⚠️ Important: Do not replace the hard disk drive and the motherboard at the same time. Doing so in the wrong order, without transferring options to the new motherboard, will cause the system to malfunction.

If troubleshooting strategies (checking cables and connections, reinstalling system software, and so forth) do not solve the problem and you suspect that the hard disk drive or motherboard is faulty, note that it is highly unlikely that the hard disk drive and the motherboard are both defective; therefore, avoid replacing both to solve one problem. Always troubleshoot in the following order.

1 Replace the hard disk drive and install system software.

   Always replace a faulty hard disk drive with a new hard disk drive. Transferring a hard disk drive from one PS-50 to another is incorrect and strongly discouraged.

2 If the problem persists, reinstall the original hard disk drive in the system, and then replace the motherboard.

If replacing a component does not correct the problem, make sure that you reinstall the old component back in the PS-50.

Table 4: PS-50 error messages and condition

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beep codes during Startup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 beep</td>
<td>No error. The PS-50 is starting up normally.</td>
<td>None</td>
</tr>
<tr>
<td>1 beep, followed by 3 beeps, followed by 3 beeps, followed by 1 beep</td>
<td>Missing, unmatched, incorrect, or faulty DIMMs</td>
<td>Check for missing, unmatched, incorrect or faulty DIMMs and reseat the DIMMs to remove any oxidation on the connector (see page 58).</td>
</tr>
</tbody>
</table>
### Table 4: PS-50 error messages and condition (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Startup</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| PS-50 does not start and the Fiery QuickTouch is black. | Possibly one of the following:  
- The PS-50 is powered off  
- Power cable is not plugged into the power connector on the PS-50 connector panel, or into the wall power outlet  
- The connector panel power switch is in the OFF position  
- Fiery QuickTouch cables are not connected to the motherboard, the Fiery QuickTouch, or both  
- Faulty power cable  
- Faulty power supply (power supply may not be supplying power to the motherboard)  
- The CMOS jumper is not in the default position  
- Faulty motherboard (motherboard power plane may not be supplying power to components) | 1. Recheck all cables and connections.  
2. Make sure the connector panel power switch is in the ON position (see page 39).  
3. Listen for the power supply fan and feel for air at the back of the unit where the power supply is located. If air is not coming from the power supply fan, isolate a possible faulty power cable as follows:  
   - Power on using a different power cable.  
   - Install a new or “known good” power supply.  
4. Check the connector panel fan vent and feel for air coming out of the back of the system. If air is coming out of the power supply fan vent but is not coming out of the connector panel fan vent, the motherboard may be faulty. You may need to replace the motherboard (see page 52).  
5. Review the jumper section on page 65 and ensure that the jumper is in the default position. |
| PS-50 is getting power, but the Fiery QuickTouch is black. |  
- Fiery QuickTouch cables are not connected to the motherboard, the Fiery QuickTouch, or both  
- Faulty LED cable  
- Faulty Fiery QuickTouch display module | 1. Recheck all cables and connections.  
2. Use a different power/LED cable.  
3. If the problem persists and you have verified that the power supply and motherboard are functioning properly as described earlier, replace the Fiery QuickTouch display module (see page 42). |
| **Fiery Ticker messages** | | |
| Please check Fiery Hardware. | Possibly one of the followings:  
- Network port is physically damaged.  
- Network driver is disabled.  
- Wrong system software has been installed.  
- Wrong BIOS chip is installed on the motherboard. | 1. If you installed the system software and this error message displays on Fiery Ticker, reinstall the system software using the correct system software media.  
2. If the problem persists, ask the site administrator if the BIOS chip has been swapped from different motherboard. If so, replace the BIOS chip with the one from the original motherboard.  
3. If the problem persists, replace the motherboard (see page 52). |
| No service dongle | Motherboard replacement dongle is not attached after you replace the motherboard and attempt to transfer options to the new motherboard. | Turn off the PS-50, attached the correct dongle, and restart the option and BIOS transfer procedure (see page 56). |
### Table 4: PS-50 error messages and condition (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fiery Quick Touch functions</strong></td>
<td>Possibly one of the following:</td>
<td>1  Recheck all cables and connections.</td>
</tr>
<tr>
<td>PS-50 is getting power, the Fiery QuickTouch screen is not black, and</td>
<td>• Problem with the Fiery application</td>
<td>2  Reboot the PS-50.</td>
</tr>
<tr>
<td>the Fiery QuickTouch is not responding.</td>
<td>• Faulty Fiery QuickTouch display module</td>
<td>3  If the problem persists, restore the backup, or reinstall Fiery QuickTouch</td>
</tr>
<tr>
<td></td>
<td></td>
<td>software (see page 91).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4  If the problem persists, restore the backup, or reinstall the PS-50 system</td>
</tr>
<tr>
<td></td>
<td></td>
<td>software (see page 88).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5  If the problem persists, replace the Fiery QuickTouch display module (see page 42).</td>
</tr>
<tr>
<td><strong>DVD drive</strong></td>
<td>Possibly one of the following:</td>
<td>1  Press the eject button below the DVD slot on the front of the PS-50.</td>
</tr>
<tr>
<td>DVD drive is not responding, cannot be located, or the disk will</td>
<td>• A disk is stuck in the DVD drive</td>
<td>2  If the problem persists, check the cable connections to the DVD drive (see</td>
</tr>
<tr>
<td>not eject.</td>
<td>• Cable connections to the DVD drive are loose or data cable is faulty</td>
<td>page 39).</td>
</tr>
<tr>
<td></td>
<td>• DVD drive is faulty</td>
<td>3  If the problem persists, you may need to replace the DVD drive (see page</td>
</tr>
<tr>
<td></td>
<td>• Motherboard is faulty</td>
<td>73).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4  If the problem persists, you may need to replace the motherboard (see page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52).</td>
</tr>
<tr>
<td><strong>System performance</strong></td>
<td>Possibly one of the following:</td>
<td>1  Recheck all cables and connections.</td>
</tr>
<tr>
<td>System performs slowly and/or hangs periodically.</td>
<td>• Board or cable connections are loose or faulty</td>
<td>2  Make sure that the CPU is firmly seated in its socket and that the fan cable</td>
</tr>
<tr>
<td></td>
<td>• System software is corrupted</td>
<td>is connected to the motherboard.</td>
</tr>
<tr>
<td></td>
<td>• Missing or faulty DIMM(s)</td>
<td>3  If the problem persists, restore the backup, or reinstall the system software</td>
</tr>
<tr>
<td></td>
<td>• CPU is overheated or faulty</td>
<td>(see page 88).</td>
</tr>
<tr>
<td></td>
<td>• Motherboard is faulty</td>
<td>4  Check for missing or faulty DIMM and reseat the DIMM to remove any oxidation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>on the connector (see page 58).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5  If the problem persists, you may need to replace the motherboard (see page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52).</td>
</tr>
<tr>
<td>Clock is slow.</td>
<td>Missing or dead battery on the motherboard</td>
<td>Replace the battery on the motherboard and update the time in the Windows (if a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>monitor is connected), Command WorkStation, or WebTools.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>page 88.</td>
</tr>
</tbody>
</table>
105

Installation and Service Guide: Printing System 50
Troubleshooting

Table 4: PS-50 error messages and condition (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The PS-50 hangs during the user software installation segment.</td>
<td>Possibly one of the following:</td>
<td>1 Set the time and date in the BIOS:</td>
</tr>
<tr>
<td></td>
<td>• The time and date need to be configured in the PS-50 BIOS. (If the battery</td>
<td>• Power off the PS-50 and remove the User Software DVD when it ejects.</td>
</tr>
<tr>
<td></td>
<td>was removed from the PS-50 motherboard during service and the time and date</td>
<td>• If not already connected, connect a keyboard and a monitor to the PS-50.</td>
</tr>
<tr>
<td></td>
<td>were not configured in Setup afterward, the PS-50 will hang during the user</td>
<td>• Power on the PS-50 and immediately press F2 repeatedly to start the BIOS setup</td>
</tr>
<tr>
<td></td>
<td>software installation segment.)</td>
<td>utility.</td>
</tr>
<tr>
<td></td>
<td>• User Software DVD is corrupted</td>
<td>• Configure the time and date. (To navigate, use the tab key and the -/+ keys).</td>
</tr>
<tr>
<td></td>
<td>• The DVD drive is faulty</td>
<td>• Save changes and exit (F10).</td>
</tr>
<tr>
<td></td>
<td>• The hard disk drive is faulty</td>
<td>• When the PS-50 reaches Idle, power off and then begin a full software</td>
</tr>
<tr>
<td></td>
<td></td>
<td>installation again, starting with the System Software DVD (see page 88).</td>
</tr>
<tr>
<td></td>
<td>2 If the problem persists, obtain another User Software DVD and begin software</td>
<td>3 If the problem persists, you may need to replace the DVD drive (see page 73).</td>
</tr>
<tr>
<td></td>
<td>installation again starting with the System Software DVD (see page 88).</td>
<td>If replacing the DVD drive does not correct the problem, reinstall the old DVD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>drive in the system.</td>
</tr>
<tr>
<td></td>
<td>4 If the problem persists, replace the hard disk drive (see page 69).</td>
<td>If replacing the hard disk drive does not correct the problem, reinstall the old</td>
</tr>
<tr>
<td></td>
<td></td>
<td>hard disk drive in the system.</td>
</tr>
<tr>
<td>Network</td>
<td>If you suspect a network problem, keep in mind the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the PS-50 does not appear in the list of printers on the network, another</td>
<td></td>
</tr>
<tr>
<td></td>
<td>device on the network may have been assigned the same Ethernet hardware address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Conflicting network settings may have been configured in Setup and on the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>customer’s workstation.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Printing problems may be caused by inappropriate Setup options.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Application-specific printing errors may be caused by missing or incorrectly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>placed printer description files.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• System software may be corrupted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For additional information, see Configuration and Setup, which is part of the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>user documentation set.</td>
<td></td>
</tr>
</tbody>
</table>
### Troubleshooting

#### Network (continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Suggested action</th>
</tr>
</thead>
</table>
| Unable to connect to the network, or the green LED on the RJ-45 network port is not lit. | Possibly one of the following:  
  - Network cable is connected to the wrong RJ-45 port  
  - No cable/wrong type of cable is connected to the network port  
  - Network cable or connection is faulty  
  - Network is faulty  
  - If the PS-50 requires a static IP address (for example, in a non-DHCP network environment), it may need to be reconfigured. A static IP address is deleted when system software is reinstalled.  
  - System software is corrupted  
  - Network interface on the PS-50 motherboard is faulty | 1 If the problem persists, have the network administrator check Network Setup. To configure a static IP address (if applicable for the customer site), work with the network administrator as described on page 22.  
2 If the problem persists, make sure that the network administrator has checked other devices on the network.  
If other devices are not functioning, the problem may be with the network.  
3 If the problem persists, restore the backup, or reinstall the system software (see page 88).  
Corrupt system software may cause the system to hang.  
4 If the rest of the network is functioning properly and the problem persists, replace the motherboard (see page 52). |

| System starts up slowly then displays one or more DHCP error messages on the Fiery QuickTouch. | Possibly one of the following:  
  - Network cable is connected to the wrong RJ-45 port  
  - No cable/wrong type of cable is connected to the network port  
  - Network cable or connection is faulty  
  - Network is faulty  
  - System searches for a nonexistent DHCP server because DHCP is enabled by default on the PS-50, but the customer’s network is not using DHCP  
  - Ethernet interface on the PS-50 motherboard is faulty  
  - System software is corrupted | 1 If the problem persists, ask the network administrator to check Network Setup. To configure a static IP address (if applicable for the customer site, as in a non-DHCP environment), work with the network administrator as described on page 22.  
2 If the problem persists, ask the network administrator to check other devices on the network.  
If other devices are not functioning, the problem may be with the network.  
3 If the problem persists, restore the backup, or reinstall system software (see page 88).  
Corrupt system software may cause the system to hang.  
4 If the rest of the network is functioning properly and the problem persists, replace the motherboard (see page 52). |
### Table 4: PS-50 error messages and condition (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printing</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: intermittent print quality and color quality problems are difficult to trace. Before you try to troubleshoot print quality problems, print a color Test Page to make sure that the printer does not need servicing or adjusting.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Page fails to print.</td>
<td>The printer is not ready to print.</td>
<td>Make sure that the printer is turned on and ready to print.</td>
</tr>
<tr>
<td>A problem exists with the connection between the PS-50 and the printer.</td>
<td></td>
<td>1 If the problem persists:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recycle power on the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recycle power on the PS-50 by shutting down through the Functions menu, waiting 10 seconds, and then powering the PS-50 back on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 If the problem persists, replace the printer interface (Data Transfer Unit) cables and board (see page 46).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 If the problem persists, you may need to service the printer.</td>
</tr>
<tr>
<td>The PS-50 appears in the list of printers on the customer’s workstation, but certain jobs do not print.</td>
<td>A PostScript error</td>
<td>1 Make sure that Print to PostScript Error in Setup is set to Yes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Check for error messages on the PS-50 output.</td>
</tr>
<tr>
<td>An application problem</td>
<td></td>
<td>1 Print a job from a different application to determine if the problem is associated with a particular application.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Make sure that the connection between the PS-50 and the workstation is working by downloading a Test Page from the workstation, or by printing a simple file such as a text file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 Resend the problem file.</td>
</tr>
<tr>
<td>A print job stalls or stops after one or a few pages.</td>
<td>Possibly one of the following:</td>
<td>1 Cancel the PS-50 print job.</td>
</tr>
<tr>
<td></td>
<td>• A PostScript or application error</td>
<td>2 If this fails to clear the problem, reboot the PS-50.</td>
</tr>
<tr>
<td></td>
<td>• System software is corrupted</td>
<td>3 If the problem persists, choose the Clear Server command from Command WorkStation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 Set Print Cover Page to Yes and resend the problem job.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Cover Page will indicate “PS Error.”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more information about the PostScript error, double-click the problem job in the Command WorkStation window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5 If the problem persists, restore the backup, or reinstall system software (see page 88).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corrupt system software may cause the system to hang.</td>
</tr>
<tr>
<td>Incorrect or faulty DIMM or faulty DIMM connection</td>
<td></td>
<td>1 Reseat the DIMMs to remove any oxidation on the connectors (see page 58).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Verify memory amount on the Configuration page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 If the problem persists after replacing the DIMM, replace the motherboard (see page 58).</td>
</tr>
</tbody>
</table>

Table 4: PS-50 error messages and condition (Continued)
Troubleshooting information

You can collect the troubleshooting information when a printing or processing error occurs. The information can be sent to technical support for the troubleshooting resource.

You can create the following information.

- Job Error Report
- System Logs

For the successful problem diagnosis, we recommend that you collect the Job Error Report, System logs, and the Printer Device Logs at the same time,

For the procedure of collecting the Printer device logs, see the service manual of the printer.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color quality is inconsistent</td>
<td>A printer problem</td>
<td>Test the printer and perform service, if necessary. See the service documentation that accompanies the printer.</td>
</tr>
<tr>
<td>Print quality is poor.</td>
<td>Possibly one of the following:</td>
<td>1 Print a PS-50 Test Page.</td>
</tr>
<tr>
<td></td>
<td>• A file or application problem</td>
<td>2 If the quality of the PS-50 Test Page is good, the error condition may be a file or application problem.</td>
</tr>
<tr>
<td></td>
<td>• A missing or outdated printer description file</td>
<td>3 Make sure that the appropriate printer description file is installed. (For details, see Printing from Windows, which is part of the user documentation set.)</td>
</tr>
<tr>
<td></td>
<td>• The application cannot find the appropriate printer description file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The system is out of calibration</td>
<td></td>
</tr>
</tbody>
</table>

Note: EPS file generation is not completely standardized among applications. Some users may encounter problems while printing certain EPS files.
Job Error Report

Job Error Report contains the important troubleshooting information that the technical support personnel can use to solve customer issues. When a user encounters a job error, system fault, or any unexpected output while printing a job, the user can generate a report from Command WorkStation. The Job Error Report is a collection of job files, logs, and server information in a zip file, and it is available from both Mac OS and Windows versions of Command WorkStation.

Note: The error log entries are overwritten after a period of time. To ensure the error logs contain the relevant information, create the job error report as soon as possible after the error is observed. Create the job error report before rebooting the PS-50 and if possible, before any additional print jobs are processed or printed.

To create a job error report

1 In Command WorkStation, select a job in the Printed or Held list.

   Only one job error report can be created at a time. If multiple jobs are selected in Job Center, the Create Error Report button is not available.

2 If accessing from a Windows client computer, press Ctrl and right-click the job. If accessing from a Mac OS client computer, press Command and right-click the job.

3 In the shortcut menu, click Create Error Report.

4 Enter information about the job error.

   a Enter any comments and additional details in the text field. The followings are recommended:

      • Date and time error occurred
      • Observed error codes, if any
      • Description of expected result
      • Description of incorrect result
      • Steps for how error occurred
      • Frequency of error (such as single event, rarely, sometimes, frequently, always)
      • Whether the error has occurred with more than one file
      • Whether the file selected for the report is the same file that had the error
      • Operating system version, if the print job was sent from a client computer
      • Version of PS-50 user software installed
      • Description of any other actions performed on the PS-50 during the same time period

   b Optional: To include the raster in the report, select Rasters.

      The raster can be useful to include if the file is not processed correctly. However, it may exceed the allowed size of the report. In this case, it may be useful to provide it separately.

   c Optional: To include color profiles in the report, select Color Profiles.

      Color profiles can be useful to include if they are custom profiles and the print colors are incorrect.
d Optional: To include the email log in the report, select Email log.

The email log can be useful to include if the file was submitted by email.

e Optional: To include the native source file in the report, click Add +.

The native source file can be useful to include if the job does not process or print. However, it may exceed the allowed size of the report. In this case, it may be useful to provide it separately.

5 Attach any additional related files to the report.

The job error report size can be up to 2GB. If the selections and attachments result in a report larger than 2GB, the report must be reduced in order to be completed.

6 Optionally, if any print jobs are considered confidential, remove the job files before sending the zip file to technical support.

7 Save the job error report.

System Logs

The PS-50 provides the ability to download system logs that can be sent to the technical support for diagnostic purposes. The logs are combined into a single, encrypted zip file, which does not contain any original job files.

To download the system logs

1 Start a web browser and access the PS-50 by entering the server name or IP address of the PS-50.

Note: If a message about an untrusted connection appears or you are asked whether you want to proceed, you can safely ignore the message and proceed by clicking Continue to website.

2 In WebTools, click the Configure tab on the left side.

3 Log on with Administrator privileges and click OK.

   The default password for Administrator is Fiery.1 (case-sensitive), but the site administrator may have changed the password.

4 On the left side, choose Fiery Server > System Logs > Download.

5 Specify the location and save the system log file.
Specifications

This section provides an overview of the PS-50 features, specifications, and safety certifications.

Hardware features

- Intel Core i7-6700 quad core 3.4GHz CPU (up to 4GHz with Turbo Boost enabled)
- Memory: 16GB (2x8GB)
- An RJ-45 connector for 10BaseT/100BaseTX/1000BaseT Mbs connectivity over twisted pair cable (upper port)
- 1TB hard disk drive standard
- Built-in DVD drive

Physical specifications

- Operating Environment:
  - Temperature: +5°C to +40°C
  - Relative Humidity: 10%-85% (non-condensing)
- Power Supply Voltage/Frequency Input: 100-240V @ 50-60Hz
- Power Supply Current Input: 100V @ 6A Max.; 240V @ 3A Max.
- Rated Power Consumption: 350W
- Dimensions (Depth x Height x Width):
  46.36 cm (18.25 in.) x 52.71 cm (20.75 in.) x 23.50 cm (9.25 in.)
- Weight: 16.56 kg (36.5 lb.)

Networking and connectivity

- Supports AppleTalk and TCP/IP protocols simultaneously.

Note: AppleTalk is supported only for downloading fonts.

Safety and emissions compliance

The PS-50 has been certified to meet or surpass the following government standards:
Safety approvals

- UL 60950-1:2007 R10.14 (TUV NRTL)
- T-Mark by TUV, EN 60950-1:2006+A11+A1+A12+A2

EMI/EMC approvals

- FCC Title 47, Part 15 Subpart B, Class B- NA
- Industry Canada, ICES-003, Class B-NA
- VCCI CIRPR 32-1: 2016, Class B- Japan
- EN55032:2015, Class B-(EU)
- AS/NZS CISPR 32: 2015, Class B
- EN61000-3-2: 2014
- EN610003-3: 2013
Servicing the PS-50 with furniture

This chapter describes how to remove the PS-50 from the furniture in order to access internal components for service.

For the assembly instruction on the Fiery NX Station, see the documentation provided with the Fiery NX Station kit.

Procedures

If the PS-50 is installed in the optional furniture, you must remove it from the furniture before performing most service procedures.

Figure 36: PS-50 installed on the furniture

Removing the PS-50 from the furniture

1. Make sure the PS-50 is powered off and all the cables are removed from the back of the PS-50.
2. Open the back door of the NX Station and remove all the cables from the connector panel of the PS-50.
3. Pull the server tray of the NX Station out of the stand.

Replacing the PS-50 in the furniture

1. Make sure that all the chassis panels are attached.
2. Lift the PS-50 and place it on the server tray.
3. Slide the tray into the stand.
4. Reconnect all the cables.
Index

Numerics
10BaseT/100BaseTX/1000BaseT 21

A
AC connector 96
AppleTalk 112

B
back panel
fan 65
backing up the configuration 89
Backup Fiery Settings 89
battery 63, 104
boards
motherboard 47
video 46
boxes, unpacking 16
bracket
HDD 70, 73

C
cables
back panel fan 65
checking 96
CPU fan 61, 63
DVD drive 38
Fiery QuickTouch 38
HDD data 38, 70, 73
HDD power 70, 73
keyboard 20
monitor 20
mouse 20
network, twisted pair 21
power supply 69
printer interface 46
unpacking 16
checklist for service calls 14, 22, 75
clearing the CMOS 65
clock 104
closing the system 75
CMOS 65
troubleshooting start up problems 103
Color Profiler Suite 91
components
checking 97
configuration
backing up 89
restoring 80
saving 79
Configuration page 23
Configure 24
browser access 24
changing language 14
saving system configuration 79
configuring a static IP address 22, 106
connections, checking 96, 97
connectors
network 18, 21, 35, 96
panel 18, 35, 96
power, AC 18, 35, 96
printer interface 18, 35, 96
USB ports (dongle) 18, 35, 56, 96
video board 46
Control Panel
display window 25
control panel
using 25
cooling assembly
CPU 59, 61
CPU 112
connecting the CPU fan power cable 63
overview 59
removing and replacing 61
removing the cooling assembly from 60
replacing the cooling assembly on 62
type 47
customer site checklist 14

D
damage, reporting 9, 16
DHCP network environment 22, 106
diagnostics, Ethernet address 105
DIMMs
configuration 58, 112
removing 58
replacing 58
display window, Control Panel 25
dongle
for entering Service Mode (motherboard replacement) 55, 56
transferring options (motherboard replacement) 53, 55, 56
drives
DVD 73
hard disk drive (HDD) 69, 73
DVD drive
cables 69
power and data cables 38
removing 73
replacing 74

Configure 24
browser access 24
changing language 14
saving system configuration 79
configuring a static IP address 22, 106
connections, checking 96, 97
connectors
network 18, 21, 35, 96
panel 18, 35, 96
power, AC 18, 35, 96
printer interface 18, 35, 96
USB ports (dongle) 18, 35, 56, 96
video board 46
Control Panel
display window 25
control panel
using 25
cooling assembly
CPU 59, 61
CPU 112
connecting the CPU fan power cable 63
overview 59
removing and replacing 61
removing the cooling assembly from 60
replacing the cooling assembly on 62
type 47
customer site checklist 14

D
damage, reporting 9, 16
DHCP network environment 22, 106
diagnostics, Ethernet address 105
DIMMs
configuration 58, 112
removing 58
replacing 58
display window, Control Panel 25
dongle
for entering Service Mode (motherboard replacement) 55, 56
transferring options (motherboard replacement) 53, 55, 56
drives
DVD 73
hard disk drive (HDD) 69, 73
DVD drive
cables 69
power and data cables 38
removing 73
replacing 74
error messages
  Fiery Ticker 103
ES-2000 Spectrophotometer 91
Ethernet
  address 105
cable 16, 21
  connector 18, 21, 35
exploded view
  CPU and cooling assembly 59

fan
  back panel 65
  CPU 59, 61
  front panel 65
Fiery pages 23
Fiery QuickTouch cable
  routing diagram 38
Fiery Ticker 23
Fiery.1 password 56
Font list
  printing prior to HDD replacement 70
front panel 18, 35
  fan 65
  layout 25
Functions menu
  Shut Down 33, 39

hard disk drive
  precautions 9
  proper handling 9
hard disk drive (HDD) 69, 72, 73
  bracket 70, 73
capacity 112
cable 70, 73
description 69
  mounting screws 72, 73
  proper handling 69
  removing 70
  replacing 72
hard disk drives
cable 69
heatsink, CPU 59, 61

job log 88
jumper(s) 65

LAN (local area network) 9
LCD 25
left panel 39
Logon Information password 56

master installer 16
memory
  configuration 58, 112
  removing 58
  replacing 58
monitor 20
motherboard
  battery 63
  cautions about replacing 52
description 47
DIMMs 58
  removing 48, 51
  replacing 52
  snap top standoffs on 51
transferring options to 53, 55, 56
  verifying in Service Mode 52, 55–56

network
cable, twisted pair 21
  connector 18, 21, 35
  supported types 112
network administrator 15
networks
  availability during installation 15
  checklist 15
  supported 8

opening the system 39

panels
  left panel 39
password 56
power
  AC cable 96
  AC connector 96
  CPU fan 61, 63
  front panel fan 65
  HDD 73
  precautions 15
  power button
  starting first time 21
Index

power supply
   cables 69
   removing 67
   replacing 68
   voltages 22, 31, 112
power, AC
   connector 18, 35
precautions 9
   hard disk drive 9
printing
   Configuration page 23, 24
   Test Page 24

R
reassembling the system 75
reboot
   server 90
   software install 80
rebooting system 31
reporting damage 9
reset button 33
restarting system software 31
Restore Fiery Settings 80
restoring the configuration 80

S
saving the configuration 89
server configuration page 23
service calls
   checklist 14, 22, 75
   Service Mode 52, 55–56
service procedures, overview 34
Setup options, recording 88
shutting down 32, 33, 39
snap top standoffs 51
software
   system 52
   user 16, 52, 88
specifications 112
spectrometer
   ES-2000 91
startup 31
   first time 21
static IP address, configuring 22, 106
system performance 104
system software
   do not install after installing a new motherboard 52
   installing or upgrading 89–94
System Software DVD 89
system upgrade 89–94

T
terminology 34
Test Page, server 23

thermal compound 53, 62
transferring options (motherboard replacement) 53, 55, 56
troubleshooting
   beep codes during startup 102
   checking external connections 96
   checking internal connections 97
   control panel functions 104
   DVD drive 104
   error messages and conditions 102
   network 105, 106
   preliminary on-site checkout 96
   printing 107, 108
   startup problems 103
   system performance 104, 105
twisted pair network cable 21

U
unpacking 16
updating the system 55
upgrading software 89–94
USB ports 96
user software 88
   do not install after installing a new motherboard 52
   installing on client systems 16
   troubleshooting problems during installation 105
User Software DVD 89

V
verifying functionality 75
verifying new motherboard installation 55
video board
   connector 46
   description 46
   removing 46
   replacing 47
   voltages
      checking 22, 31

W
Windows OS
   password 56
# Parts List

## Printing System 50

This document provides part numbers for spare components for the Printing System 50. To locate a particular component, see the following sections and illustrations.

**Note:** Replacement parts and specifications are subject to change. For the most current information, see the parts list maintained by your authorized service/support center.

<table>
<thead>
<tr>
<th>Part</th>
<th>Part number</th>
<th>References for additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motherboard kit (includes spare motherboard, motherboard replacement dongle, cooling kit backplate, and documentation)</td>
<td>45202370</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Printer interface board</td>
<td>45186179</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Intel quad-core i7-6700 CPU 3.4GHz</td>
<td>45183155</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Part</td>
<td>Part number</td>
<td>References for additional information</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Cooling assembly (fan and heatsink)</td>
<td>45110862</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Power supply</td>
<td>45173850</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>1 TB SATA hard disk drive</td>
<td>45148915</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>DVD drive</td>
<td>45162407</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Part</td>
<td>Part number</td>
<td>References for additional information</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>DIMM (8GB)</td>
<td>45168631</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>SATA interface power cable</td>
<td>45092809</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>SATA hard disk drive data cable</td>
<td>45053218</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Rear panel fan</td>
<td>45162406</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Power cable</td>
<td></td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td></td>
<td>45053564 (US)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>45053565 (EU)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>45053566 (AUS)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>45054061 (UK)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>45096959 (CHN)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>45110178 (TW)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>45057726 (JP)</td>
<td></td>
</tr>
<tr>
<td>Part</td>
<td>Part number</td>
<td>References for additional information</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Front panel</td>
<td>45183162</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Top panel</td>
<td>45173852</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Side panel (right)</td>
<td>45173854</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Part</td>
<td>Part number</td>
<td>References for additional information</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Side panel (left)</td>
<td>45173855</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>Display module for Fiery QuickTouch</td>
<td>45173856</td>
<td>Installation and Service Guide</td>
</tr>
<tr>
<td>27-inch flat panel monitor</td>
<td>45148350</td>
<td>n/a</td>
</tr>
<tr>
<td>22-inch flat panel monitor</td>
<td>45177175</td>
<td>n/a</td>
</tr>
<tr>
<td>Part</td>
<td>Part number</td>
<td>References for additional information</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>USB keyboard and mouse pack</td>
<td>45162412</td>
<td>n/a</td>
</tr>
</tbody>
</table>